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Overview

What BMPTOICO does
.    Creates...
.    Edits...
.    Converts...
...Icons, Cursors, and Small Bitmaps

BMPTOICO being a 16-bit Application, it allows users who are still running Windows 3.1 or Windows NT 3.5 to access the rich 
world of Multi-Format Icons.    But since I have a 32-bit Operating System, I added many features that are only available for that 
OS.    I tried to make this Help File as clear a possible regarding what can be done with which OS (see: Special Icons used in this
Help File).

 Picture with PopUp Help.

Quick Start
1     Find a Directory with .ICO and/or .BMP Files
2     Double-Click on a File Name to Open the Image
3     If you want to change something, do it.
4     Click the Convert or Save Button 

Help
Help in BMPTOICO is Context-Sensitive: if you Press F1 in any module that has an Help Menu or an 
Help Button (or Click that Menu or Button), this Help File will open at the appropriate Topic.

Minimum System Requirements
.    386 PC (it will work, but very slowly...)
.    8 megs of RAM (more if possible)
.    Windows 3.1 or more
.    Any Video Card (except Monochrome)
.    Around 1 Meg of Drive space

But...
Many BMPTOICO features are only available for 32-bit systems.

What's New in Version 4.0
.    Cursors are supported (with Test and Hot Spot setting)
.    Web and Meta Files can be Opened
.    Create and Edit a New Image
.    See all Icon Formats at once, Add/Delete them
.    Increase/Decrease an Image's Color Depth
.    Resize an Image
.    More and Better Editing Tools
.    A Bitmap Buttonizer, and other Special Effects
.    Many cosmetic changes

History
BMPTOICO
Ver. 1.0 (July 1995):    A small two-ways Converter, but already has View All and Crop Modules. 
Ver. 2.0 (June 1996):    A simple Editor is added; View All is improved.
Ver. 3.0 (April 1998): Multi-Format Icons support, much improved Editor, Crop, View All.
Ver. 3.1 (Dec. 1998):    Long Filenames, Move Tools, etc.

ICOEDIT
Ver. 1.0 (April 1997): When my ambitions for BMPTOICO's Editor got too big to handle, I decided to release an 

Icon Editor as a separate Application.
Ver. 1.5 (December 1999): Long Filenames and better understanding of High and True Color Video Modes.

Now that most people have bigger and faster systems, or at least more memory, ICOEDIT is put to rest, and 
BMPTOICO takes over as a complete Editor, while maintaining its Converter Functions.





Special Icons in this Help File

BMPTOICO can be used on most Windows systems, but some features are available only to specific systems; in 
addition, some functions are available only for Images of specific Color Depths. In this Help file, small Icons identify 
Help for specific situations:

Windows Version:
16-bit: Win 3.x, NT 3.5
32-bit: Win 9x, NT 4.00, 2000

System Video Mode:
16 Colors (4-bit)
256 Colors (8-bit)
High Color (16-bit)
True Color (24-, 32-bit)

Image Color Depth:
2 Colors (Monochrome)
16 Colors
256 Colors
True Colors (24-bit)

and... VGA 16 means "Windows' Standard Palette of 16 Colors" (see it)

Aren't "Video Mode" and "Color Depth" the Same Thing?



Main Form

(Click on elements of the picture below for more information)



Supported File Formats

BMPTOICO is a Paint Program for Small Images. It supports the following Formats:

Icons and Cursors

Bitmaps (and Metafiles)
      Crop BMPs  



Formats: Icons and Cursors
Back to: Supported File Formats

Icons     (.ICO files)
Little Images that identify a File on the Desktop, the Explorer or File Manager, etc. They look better with a 
Transparent Background. They can have more than one Format in the same File. 

Cursors      (.CUR files)
Replacements for the Windows Mouse Pointer. They are special Icons that need to measure 32x32 pixels, 
should have a Transparent Background, and one pixel called the "Hot Spot" used by Windows to know where 
you are pointing.

Notes
.    In this Help file, the term "Icon" also refers to Cursors, unless it says otherwise...
.    Animated and OS/2 Icons and Cursors are not supported

Dimensions supported
Icons: Any, from 8 x 8 to 72 x 72 pixels, even Rectangular ones (but Windows' Explorer    will always 

show them square, and with fixed sizes limited to 16, 32, 48 and 64).
Cursors: can only measure 32 x 32 pixels

Color Depths supported
All, from Monochrome to True Colors.    BMPTOICO will open them only if the Icon's Color Depth is the same, or 
less, than the System Video Mode.

16- and 32-bit Icons are quite rare, and perhaps should not be mingled with...    BMPTOICO can View them, but 
not Open them.

Transparency
True Icons and Cursors can have Transparency.
Icons that are really Bitmaps saved with the .ICO extension are treated as pure Bitmaps by BMPTOICO, and 
cannot have any Transparency, but 32-bit Windows can create Fake Transparency for them.

See also:
What is "Transparency" in Icons?
What are Multi-Format Icons?
Can I use a Bitmap as an Icon? 
Any Image Palette Restrictions?      and Windows?
Why can I "View" an Image, but not Open it?  
Aren't "Video Mode" and "Color Depth" the same thing?



Formats: Bitmaps (and Metafiles)
Back to: Supported File Formats

Bitmaps     (.BMP, .GIF, .JPG/.JPE files)
Images created from individual screen pixel information. There are many common bitmap formats, but 
BMPTOICO can only deal with Windows BMPs and Web files.
Note: OS/2 Bitmaps are not supported.

Metafiles     (.WMF files)
Special files that can contain Vector (formulae) data, Bitmaps and Text; BMPTOICO only supports the Windows 
Metafile Format , and can only Open the first Image in them.    .EMF Files, specific to 32-bit Windows, are not 
supported.

Can I Open Web Files in BMPTOICO? 
Other Graphic Files?

Dimensions supported
Any, from 8 x 8 to 72 x 72 pixels, even Rectangular ones.

Too big?
Images that are bigger than 72 x 72 pixels are automatically opened into BMPTOICO's CROP Module.

Color Depths supported
Bitmaps 

All, from Monochrome to 32-bit True Colors.

16-bit and 32-bit BMPs can be Opened, but will be treated as 24-bit Bitmaps internally. If you Save them under 
the same name, they will be Saved as 24-bit, so be careful.

You can Open Bitmaps that have a Resolution higher than 256 Colors via the Special Loading module, but they 
will be treated as 256-Colors Bitmaps in memory, and will be Saved as such.

Metafiles
Because of how Windows works, some restrictions apply, depending on your Video Mode:

 Can be Opened only if a true Bitmap is found in the Meta file, and it has 2 or 16 Colors; otherwise, Windows 
would dither the colors.

 Any .WMF File can be Opened if it contains at least one Image, whether it is a True Bitmap or not.

BMPTOICO will only Open the first Image found, and does not take any other information (vector, text) into 
account. Once Opened, they are treated as BMPs internally, and will be Saved as such.

GIFs
They can only have 16 or 256 Colors, and need to be Opened via the Special Loading Module. If the GIF is 
Animated, you can select the Image you want. Once Opened, they are treated as BMPs internally, and will be 
Saved as such. 

JPEGs
They can only be True Colors (24-bit), and need to be Opened via the Special Loading Module. Once Opened, 
they are treated as BMPs internally, and will be Saved as such. 

Only JPEGs that were Saved with the "Baseline" process can be Opened (a limitation of the DLL). 

 Cannot be Opened
 Can be Opened, but they will be treated as 256-Colors Bitmaps in memory, and will be Saved as such.

Transparency
Bitmaps never have Transparency.



See also:
Any Image Palette Restrictions?      and Windows?
Why can I "View" an Image, but not Open it?  
Aren't "Video Mode" and "Color Depth" the same thing?



Crop BMPs
Back to:Bitmap Formats

If the Bitmap    you wish to Open into BMPTOICO    is larger than 72 x 72 pixels, or if you Grab from Screen, the Crop 
Form will automatically open. 

 Picture with PopUp Help.

Open as a Thumbnail...
If all you want is a tiny version of the complete Bitmap, Click the Open Thumb. Button, and the Thumbnail will be 
sent immediately to BMPTOICO's Main Form. No Cropping needed!

Or... Crop a Smaller Image
The Bitmap is displayed in the View Window. If it doesn't fit, use the Scrolls to Change the View    or, even faster, 
Click the Thumbnail Image.

1    Select the Crop Size
In the Combo Box at upper right.    The List is restricted to Sizes that are smaller than the Image, up to 72 x 
72.pixels.

2    Crop with the Cursor 
Its Size and Position are Displayed above the View Window, and its content will show in the Crop Icon at the 
right (updated when you Move or Resize the Cursor). 

Move the Cursor
Click the Arrow Buttons, or Press [Arrows] (Auto repeat). Use the "Step" Scroll to Change the Moving rate.    
You can also Drag and Drop the Cursor inside the View Window.

Resize the Cursor
Click the Arrow Buttons in the bottom Frame, or Press [Page Up/Down] (Auto repeat) to Enlarge or Reduce the 
Cursor. It can be as small as 4 x 4 pixels, but never bigger than the View Window. Click the "[Resize] Step" 
Scroll in this frame to change the Resizing rate.
MORE HELP:    Resize the Cursor, with pictures

Change the Cursor's border
Its Border is normally Inverse-Color, but if you prefer a Black one, Right-Click the Cursor, or Check the "Black 
border" Box.

3    View Buttons / Menu

Full
Shows the complete Image. Disabled if the whole image fits into the View Window.

Zoom
See a Blowup of the Cropped Icon. Same as the Zoom Button above the View Window.

4    OK, Done
Click the Done Button to send your Cropped Image to BMPTOICO's Main Form, ready to be Edited, Saved or 
Converted into an Icon.      Or Cancel the Crop module.



Crop Form
Back to:Bitmap Formats

(Click on elements of the picture below for more information)



Crop: Resize the Cursor
Back to:Bitmap Formats

By Default, the Cursor is the same Size as the Crop Size: the bottom frame's Caption is labeled "Cursor = Crop", and 
Selecting a new Crop Size will automatically reset it. But you can Enlarge it to Shrink the Cursor View to fit a smaller 
Crop Size, or Reduce it to Blow the Cursor View to fit a bigger Crop Size. While in SHRINK or BLOW View, Selecting 
a new Crop Size will not reset the Cursor.

The Current Cursor Size is always visible above the View Window. To quickly Reset it to the Crop Size, Click the "=" 
Button.

How to SHRINK... 
Click the Right Arrow Button, or Press [Page Up], to set a Cursor Size Higher than the Crop Size. This will 
Enlarge the Cursor, and    the Image Region under it will be Shrunk to the Crop Size:

How to BLOW...
Click the Left Arrow Button, or Press [Page Down], to set a Cursor Size Lower than the Crop Size. This will 
Reduce the Cursor, and    the Image Region under it will be Blown to the Crop Size:



Special Loading Module
Back to:Bitmap Formats

This module is used...
 . Any time you want to Open a Web File.
 .  If you Open BMP Files that are High or True Colors 

This Module needs the VBJPEG.DLL and FILE.DLL Files provided with BMPTOICO.

How it works
1        Open the file in BMPTOICO: if the Special Loading Module is needed, it will Open automatically and will Load

the Image (or give an Error message) and display its File Name, dimensions and number of colors.    

If the Image is a GIF, it will tell you the Type (87a or 89a) and if it has a Transparent Color (it will show it) or not;
this is for information only, as once opened it will be a Bitmap, and all colors will be part of the Foreground.    If 
the GIF is Animated, Use the "ANIMATION" Scroll to Select the Frame you want.

2        Click the Open Button to send the Image to BMPTOICO. If it is larger than 72x72 pixels, it will be sent 
automatically to the Crop module. Or Click the Cancel Button.

 Windows will reset its System Palette to the Image (this is why this module needs to be Full Screen...). BMPTOICO will use 
that Palette. The Image will be treated as a 256 Colors Bitmap in memory, and will be Saved as such.    Most Bitmaps don't suffer 
too much from the reduction, and you might want to use them.

Credits
This Module is adapted from Joe C. Oliphant's "Graphic Viewer 2.0", a freeware Visual Basic code example, from 
which I took the VBJPEG.DLL and FILE.DLL files used in BMPTOICO. The VBJPEG.DLL code is based in part on 
the work of the Independent JPEG Group.



Open / Create a File

Open an Existing File...

.  Navigate...    Double-Click a Filename in the File lists

.  PopUp menu (Right-Click on a File Name)
Select Open (if    Enabled)
Select View, then Click its "Open Now" Button (if Enabled)

.  View All 

.  Icon Extractor

.    File Association 

or...

Create a New One

.    New Image Wizard



File Lists: Navigation
Back to: Open/Create a File

The Two File Lists show All Files in the Current Open Path:

List File Type Extensions.
Left Icons .ICO, .CUR
Right Bitmaps .BMP, WMF 

(+ Web Files)

 Long filenames are used. To Change the Width of the Folder or File Lists: move the mouse pointer over the Dividers between 
the Lists, Click a Mouse Button and Drag it.

1      Select Drive and Folder
Use the Drive and Folder Lists at left to change Folders (Directories).

. The Current Open Path is always displayed below the file lists.

. The Current Save Path is the same as the Open Path if the Drive is not Read-Only.

If the Drive is Read-Only...
If you cannot Save to the current Folder (for ex. on a CD-ROM), BMPTOICO will ask you to select 
another Save Folder when you first select the Drive; the name of that Folder will be shown at the 
bottom Under the Current Open Folder path name, and you can change it later by Clicking the 
Change Button located at the right of the Save Path Name (the button is only Visible if the Save Path 
Name is displayed).

Image/Folder Synchronization
By Default (when you Open/Create/Save/Convert an Image), Selecting a New Folder will Unload any Opened 
Image; it it has been Modified, you will first be asked if you wish to Save it. You can Un-Synchronize Image and
Current Folder by Setting the Lock Button down, or Un-Checking the "Synchronize w/Folder" item in the File 
Menu (see: Synchronize File Function).

2      Select a File
The Filename will be highlighted. Click the Mouse Right Button to see the PopUp Menu, or Double-Click with the 
Left Button to Open it.

3      Open a File
Double-click on the Filename, or press [Enter], or Select "Open" in the PopUp Menu. You will get an error 
message if the File cannot be Opened (it can be Bad, or its Color Depth is beyond your Current Video Mode).



File Lists: PopUp Menu
Back to: Open/Create a File

Right-Click on a Filename to see this menu (the Filename needs to be be Highlighted).    All the functions apply to the 
File on Disk, NOT to the Image in memory.

Info
Information on the Disk File:    Dimensions in pixels, Color Depth, Date, Length. For Multi-Format Icons, 
Dimensions and Color Depth of each Format.    Also: If the file Cannot be Opened (Invalid picture, your video mode
is not up to it, etc.), or if it is Read-Only.

      
View    

Shows the File Image in Actual Size.    Click the Open Now Button to Open it in BMPTOICO.    Can also show 
some type of Images that cannot be Opened, but is always Disabled for Web files (they cannot be Viewed at all).
See also:    Why can I "View" an Image, but not Open it?

Open
Will Open the file into BMPTOICO or give you an Error message (same as Double-Clicking on the Filename, or 
Clicking the Open Now Button in "View" above). Disabled if the Image cannot be Opened.

Show    to Compare
Visible only if the Highlighted File is a BMP or WMF, and your Video Mode is High Colors or more. Same as View 
above, but Displays the Bitmap in a special Form that will stay on your Desktop for as long as you need it.

Picture and more help:
How Do I... Compare the Image I am Editing with Other Images?

Delete
[Not Visible if the Disk is Read-Only.] Will Delete the Highlighted File; you will be first asked to Confirm it.    If the 
File is currently Opened, it will the Unloaded from BMPTOICO.

Rename
[Not Visible if the Disk is Read-Only.] Will ask you for a New Name for the Highlighted File. If the File is currently 
Opened, the Display Filename will be updated.    

Copy (same folder)
[Not Visible if the Disk is Read-Only.] Will ask you for a New Name, which must be a different one.

Change Ext. 
This item is Visible only in the Right File List. Its Caption changes according to situation:

Change Ext. (BMP>ICO)    
 only. Quickly set a Bitmap as an .ICO File (see FAQ)

Change Ext. (JPE>JPG) 
Quickly change the Mac extension .JPE to .JPG, preferred by PC applications, if you are working with Web files.

Move, Copy > other folder
Will ask you for the name of the Folder where you want to Move of Copy the file. When you click OK in the Ask 
module, you are asked if you want to move to the New Folder, or not.

 



 New Image Wizard
Back to: Open/Create a File

1      Open the Wizard
Click the New button, or Click File  New, or Press [CTRL+N]. If an Image is already Opened and it has been 
modified, you are first asked if you want to Save it.    

2      Select the Image Type
1 - Icon
2 - Cursor
3 - Bitmap
4 - Button (Bitmap)

Click on the Image representing your Choice, or Press the corresponding number: the Wizard will display the 
next page (you can always change your mind by Clicking the Back button). 

3      Select the Color Depth
Choices:    2, 16, 256, True (Colors; Default is 16).

 No 256 or True Colors Choices, since you can't Edit Images with those Color Depths.

4      Select the Size
Choices:    16 x 16, 32 x 32, 48 x 48, 64 x 64, 72 x 72 (Pixels; Default is 32 x 32).
 
Bitmaps (and Buttons):    Custom...

...Square: one Scroll controls both Width and Height

...Rectangle: two Scrolls, labeled W[idth] and H[eight], that work independently from each other
Use the Scroll(s) to set the Image Size to any Size between 16 x 16 and 72 x 72.    

Cursors
Since they must measure 32 x 32 Pixels, this Option is not available.

5      OK, Done...
When you Click the OK button, the Editor will open automatically. If you Create a New Button, the Buttonizer will 
open first, then the Editor (you can still Cancel the New Image by Clicking the Cancel Button in the Buttonizer or 
the Editor).

You can also Click the Cancel Button to Cancel the Wizard.



Editor

Open it...
Click the Edit button, or Click File  Edit, or Press [CTRL+E] or [ALT+E].    

This Button is Disabled if the Opened Image cannot be Edited.

Help Topics
          

 Picture with PopUp Help.
General Notes
Buttons

Colors Tools Menus
Palettes
Mix
Color Options
Show Use
Edit Colors

Move
Paint
Text
Magnifier

Image
Tools 
Edit
Undoes
Options

How to Edit
1    Select a Tool
2    Select Colors from the Palette(s)
3    Select a Color Option (Icons only)
4    Use the Tool



 Picture
Back to: Editor Main Topic

This example if for a 16-colors Icon, using the Draw Tool. 256- and True Colors Images have a second, 240-Colors 
Palette at the right of this Form.

(Click on elements of the picture below for more information)



 General Notes
Back to: Editor Main Topic

Auto...
The Editor opens automatically when you Create a New Image or Add a Format to an Icon File.    If you Change an
Image's Color Depth, you are asked if you want to Edit it (or not).
See also 

Undo...
·    Click the UNDO/REDO Button to reverse the last operation, or Click Undoes  Undo[Redo] Last

·    Double-Click the "Undo to:" Image at upper right to return to the state of the Image before the last Tool change.
·    Click Undoes  Reload Original Image if you messed up.

MORE:    Undoes Menu

Limitations
Because of Windows' Palette Restrictions, Images with 256 or True Colors can only be Edited if your Video Mode 
is set to High (16-bit) or True Color. In 256 Colors Video Mode, Windows insists on Dithering the Colors for the 
Paint Functions.

Cursor Position
While the Mouse Pointer is in Editing Area, BMPTOICO always tells you its position (below the Area, lower left); it 
also tells you if a pixel is part of the Foreground or is Transparent (or Inverse Screen). 

Global Functions are only Available in the Main Form...
Exit to BMPTOICO's main form if you want to Change an Image's Size, Color Depth or Aspect (Special Effects).    If
the Image is an Icon or a Cursor, you can also Add Formats to the File, or Delete Formats from it.
See also

Some Warning messages when you Open the Editor...
NO BLACK 

If you Edit an Icon with a Palette (256 Colors or less), and this Palette does not contain Pure Black, you will be 
asked to add it to the Palette. If you answer...

Yes: Black will be added, and all pixels of the Color that is closest to it will be changed to Pure Black.
No:      The Editor will consider your image as a Bitmap. It will not offer the Transparency-related functions and 

Colors, because Transparency needs Pure Black. 

16-BIT DISPLAY
see Why does 16-bit Video Mode not Display Colors correctly?



    Buttons
Back to: Editor Main Topic

These Buttons are located at the bottom right of    the Editor. Except for Undo,    all Buttons have equivalent items in 
the Image Menu.

More Editor Buttons: see Move Functions, Paint Tools

    UNDO / REDO          [CTRL+Z]
Same as Clicking Undoes  Undo/Redo Last.    Enabled each time you use a Paint Tool (it will work both 
ways until you perform another operation), Disabled if no reversing can be done.    If you are using the Move 
Tool, only one UNDO Click is permitted, and no REDO.

    Check Transparency
Displays the Icon's Mask in the Editing Area, showing which pixels will be Transparent.    Disabled if you are 
Editing a Bitmap. 

    Test the Cursor
Visible only if you are Editing a Cursor. Opens the Cursor Test Form.

    Save
Enabled only when you have modified the Image or a Palette. Saves the Current Image with any modification 
to the Image done in the Editor so far (see Save a File; if you have Edited a 256-Colors Image's Palette, it will 
be updated at that point and Saved with the File).

    Cancel
Exits the Editor, discarding any modification to the Image or the Palettes. If you have Saved from the Editor, 
this will only Cancel the modifications done after the Save.

    Done
Exits the Editor and returns to the main form with all the modifications to the Image and/or Palettes.



    Palettes
Back to: Editor Main Topic

If the Image has a Palette (i.e. if it has 256 or less Colors: its Color Definitions, or "Image Palette", is embedded in the
File), the Editor will use it. If it doesn't (True Colors Images), you can use any Color.

To Select an Active Foreground Color
Click a Color in a Color Palette with the Left or Right Mouse Button.

The Editor's Display Palettes...

Small          16 Colors, located under the Tool buttons

Big 240 more Colors at the right, if the Image has 256 or more 
Colors

Mix Visible if the Image has 256 or more Colors; if the Image has 2 or 16 Colors,
you can still "Mix" two Colors.      See  Mix Colors for more.

In detail, if the Image is...

              No Palette, since there are only Two Colors.

         All Colors are Displayed in the Small Palette. If they show Dithered, see Why are the Colors in my 16-
Colors Icon all Wrong?

    The First 16 Colors are in the Small Palette, the 240 remaining ones in the Big Palette.    If you Create a New 
Image, BMPTOICO uses a Generic Palette.    Both Palettes can be Edited: Select the Color you wish to Edit as an 
Active Foreground Color.

VGA 16 Colors: When you Edit an Image for the first time, BMPTOICO looks for these Colors in the 
Image's Palette; if it does not find them, and there is room at the end, it will add as many as it can fit. These 
Colors will become part of the Image's Palette when you Save or Convert it.

    These Images can use any Color. BMPTOICO gives you the choice of three sets of Display Palettes: Use the 
Tabs above the Big Palette to select them.

Image
Built from a range of Colors in the Image; if BMPTOICO found less than 256 Unique Colors, the remaining
Palette Cells will be White.    Disabled for New Images, since it is empty.

Windows
(Default choice when the Editor opens): A complete range of Colors; the Small 16-Colors Palette is 
Windows' Standard.

Pool/+
Full Spectrum of Colors (the Small Palette is Windows' as above).    In addition (+), this Palette has Cells 
at the bottom, which can be filled with Edited Colors. 



    Mix Colors
Back to: Editor Main Topic

The Mix Function, Visible when you Select any    Paint Tool, works differently if you Edit a 2/16 Colors Image, or a 
256/True Colors one. 

If the Image is...
 , 
      

.    Left Button:    to Paint with Solid Colors (Default)

.    Right Button: to "Mix" the Left and Right Foreground Colors; the resulting shade is displayed besides the 
button while it is down. Using the Left or Right Button to Paint will determine how the Colors Alternate. Disabled
if Select the "Alternate" or "Transparent" Color Options (Icons only).
                                            

 , 
        

Click it to Create a Mix Palette of 8 shades obtained by mixing the two Foreground Colors. Click the little "X" 
button to hide the Mix Palette.

To Use the Colors:

 Since you can only use a Color that is present in the Image's Palette, you must first Copy the Color you want to 
the Small or the Big Palette: 

1  Click on the Color in the Mix Palette. leave Button depressed
2  Drag the Mix symbol to the Palette cell you want to replace
3  Drop the Color: it is now your Left Button Foreground Color. 

BMPTOICO warns you if the Color being replaced is used in image (you can Cancel the Drop). The Drag 
CheckBox is Checked and Disabled, since Drag is the only possible way to Select a Mixed Color. 

    Use the Left or Right button to Select the Color in the Mix Palette.    If you want to keep it in a Palette, Check 
the Drag Checkbox (not labeled, located at right of the Mix Palette). The instructions are the same as those for 256-
Colors Images, except that    the Dropped Color will not be automatically Selected as Foreground Color.



    Color Options
Back to: Editor Main Topic

If you Position the Mouse Pointer over one of the Current Colors, the Tool Tip at lower left will tell you what you can 
do with it:

. Show Color Use 

. Edit the Color (256/True Colors Images, Foreground Colors only)

. Change the Transparent Color (Icons only, see below)

Bitmaps
Only the two Foreground Colors are available; they work the same way as for Icons.

Icons and Cursors: Select an Option

Click on a Color Swatch to Select a Painting Option. The Selected Option is Displayed bigger than the other two.

    Foreground
The Left button will paint the Left Color, the Right button will paint the Right one. Click the Squared Arrow to 
permute them.    This is the only Option available if you Edit a Bitmap.

To Select Foreground Colors
Click a Color in a Color Palette with the Left or Right Mouse Button.

    Alternate
The Left button will paint the Left Foreground Color (the Permute Arrow is still active), the Right button will paint 
Transparent. 

    Transparent
The Left button will paint Transparent, the Right one will paint "Screen Inverse". 

To Change it
Click the Left Button Color while this Option is selected and Select a new Color in your Current Small Palette (the
"Screen Inverse" Color will be automatically updated).

MORE ON:    Transparency



      Show Color Use
Back to: Editor Main Topic

You can See If and How a Color is used in your Image (Foreground Colors only if you Edit an Icon). Position the 
Mouse Pointer over any Color Option Swatch, and the Tool Tip at lower left will tell you can see its Use or not. 
          
Right-Click on the Color; if it is...

.    Used in the Image: All Pixels of that Color will briefly Flash.

.    Not Used: you will hear a Beep.

 BMPTOICO might have problems finding the Color you want to check if it was Selected from a Palette. To make sure you get 
the right Color, use the Pick Tool    to get it from the Image itself (see Why does 16-bit Video Mode not Display Colors correctly?).



    Color Editing
Back to: Editor Main Topic

If your Image has 256 Colors or more, you can Edit the Active Colors (Foreground Colors only if you Edit an Icon). 
Position the Mouse Pointer over any Color Option Swatch, and the Tool Tip at lower left will tell you if it can be Edited 
or not. 
          
How to do it...

1     Select the Color you wish to Change as a Foreground Color.
2      Double-Click it with the Left Button to Open the COLOR EDITING Form. 

The COLOR EDITING Form
If the Color you are Editing is present in the Image, All Pixels of that color will Flash briefly (same as Show Color 
Use, with the same 16-bit Display problem). 

    Picture with Complete PopUp Help.
How do I.... Keep a List of my Favorite Colors?

To Get the New Color
Use the RGB (or HSL) Scrolls, or the Value Text Boxes, or the Palettes at the right (Click the Button with a little 
Palette to Display them), to Select a Color. 

The Values can be Displayed or Entered in Decimal or Hexadecimal notation (the Default Setting Form opens 
depends on your current RGB Values Option).

OK, Done
Click the OK Button: You can use the New Color Immediately with any Paint Tool. Or Click Cancel.

If the Image is...
 The Color will be automatically Replaced in the Editor's Palette; if it was Found in the Image, it will be Replaced 

there by BMPTOICO as well, and the Undo to Image will also be updated. If both Foreground Colors have the same 
Palette Index, the other one will also be replaced. 

    No Restriction.    Editing a Foreground Color will NOT replace it in the Editor's Palette (but you can use the 
extra cells of the Pool/+ Palette to store a New Color for future use with this Image). If the Old Color was Found in the
Image, it will NOT be replaced, UNLESS you Check the AUTO-REPLACE Box.

Permanence of the New Colors in the Palettes
The Image's Palette in memory, distinct from the one displayed in the Editor,    will be updated only when you Save 
the Image from the Editor, or Exit it with the Done Button. In Detail, if you Click these Editor Buttons...

Button Action
Cancel All Color Changes are lost

Done
Save

The Changes are Committed to the Image's Palette 
in BMPTOICO's memory, and...

The Edited Palette will be saved with the File when 
you Convert or Save it.

The Pool + Palette will remain attached to the Image 
as long as it is in memory, but will not be kept when 
you Convert or Save it.    



    Color Editing: Picture
Back to: Editor Main Topic
This example is for Editing a Color in an Image with True Colors; the Pool Palette and the Favorites Colors in this 
picture have been decreased to 16 colors to please WinHelp, but will show in all their glory in BMPTOICO...

(Click on elements of the picture below for more information)



    Move Tool
Back to: Editor Main Topic

Selects a Region in the Editing Area, allowing you to Move, Copy or Delete it. Click the Move Tool Button, or Click 
Tools  Move, or Press [CTRL+M]. The Edit Menu will be Enabled, and the Move Functions Buttons will be 
Visible.

1      Select an area...
To... Use Mouse's 
Move the Selection Left Button
Copy the Selection Right Button

1    Click in the Editing Area with a Mouse Button to anchor one corner of the Region you want to select 
2    Drag the mouse until the flexible box that appears surrounds the Region you want to Select
3    Release the button

If you make a mistake while Selecting, Click outside of the Selected Region and start over.

2      Or Select All...
Press [CTRL+A] or Click Edit  Select All.

3      Perform an Operation
Move or Copy    the Selected Region within the Image; many ways to do this:

. Click inside its borders (where the Cursor changes to four white arrows), Drag the Selection where you want it, 
Release the button

. Use the Nudge (Arrow) Buttons.

. If you have Magnified a portion of your Image, the Selected Region will stay put if you use the Scrolls to display 
another portion of your Image.

Move Functions Buttons: Click them (or Select their corresponding Edit Menu items) to Flip, Rotate, Cut, Copy 
or Paste the Selection - or the whole Image if No Region, or All, is Selected.

 
4      Commit the Selection...

.    Click outside it in the Editing Area, OR

.    Select "Commit Selection" in the Edit Menu, OR

.    Click the Commit Button (Red Check) in the Move Functions, OR

.    Cut or Copy it (Move Functions), OR

.    Start another operation
 

5      ...Or Cancel it
Click the UNDO Button, or Press [CTRL+Z].    No REDO possible.



    Move Functions
Back to: Editor Main Topic

These Functions, accessed via Buttons or the Edit Menu, are visible only when you Select the Move Tool.    Disabled 
if you Magnify the Image, but will be re-Enabled as soon as you make a Selection.

Apply to
.    Selection Only:    if you have Selected a Region with the Mouse
.    Whole Image:      if no Region is Selected, or you have "Selected All" 

Select All
Click Edit  Select All, or Press [CTRL+A].

    Commit Selection
This Button is Enabled as soon as you use any Move Function. Click it to Commit the Change to the Image. You 
can also Click Edit  Commit Selection, or Click anywhere in the Image, but outside the Selection, to Commit it.

Undo
Click the UNDO button, Click Undoes  Undo Last, or Press [CTRL+Z], to Cancel any change (no REDO 
possible).

    Nudge
Click to Nudge (Move) Left, Right, Up or Down, one Column or Row at a time. Or Click Edit  Nudge 

 Left | Right | Up | Down.

    Flip
Click to Flip Horizontally (Mirror) or Vertically. Or Click Edit  Flip 

 Horizontal | Vertical.

  Rotate 
Click to Rotate Left or Right. Or Click Edit  Rotate 

 Left | Right. Disabled if you have Selected All and the Image is not Square, or if you have Selected a 
Rectangular Region and there is no room to Rotate it in the other direction (it is too close to the bottom or the right 
border).

    Cut, Copy         [CTRL+X, CTRL+C]
Enabled once you have Selected a Region, or All.    Click the button, or Edit  Cut / Copy, to Send the Selection
to the ClipBoard. Check what was sent by Clicking Image 

 ClipBoard Viewer.

Notes:
. Cut will also Delete the Selection from the Image.
. Icons are always Copied as Bitmaps (Transparency is not preserved).
. Both Functions are disabled after you have Moved, Flipped or Rotated a Selection; this is by design.

Delete                    [Del]
(No Button)    Deletes the Selected region from the Image, without Sending it to the ClipBoard.    You can always 
UNDO the operation.

    Paste    Opaque or Transparent             [CTRL+P, CTRL+V]
see Pasting.



    Pasting
Back to: Editor Main Topic

Only available when you Edit an Image.    It is a Move Function: the two Buttons, and the Edit Menu item, are Visible 
only when you Select    the Move Tool. They are Enabled as soon as a Bitmap is in the Clipboard, whether copied 
from BMPTOICO or from another application.

How to Paste...

Click one of the two Paste Buttons, or Click Edit  Paste Opaque or Edit 
 Paste Transparent. 

Paste Hot Key Action

 Opaque [CTRL+P] All pixels are pasted over those
of the Image

 Transparent [CTRL+V] Transparency is created by setting 
All Pixels of the Current "Pasting 
Transparent Color" (see below) in 
the Pasted Snippet as Transparent.

BMPTOICO will Adjust the Colors of    the Pasted Snippet to the Palette of the Image being Edited, unless this 
Image has True Colors. 

You can always UNDO a Paste Operation or Delete it.

"Transparent Color" when Pasting
It is shown at the right of the Paste Transparent Button.

If you Edit It will be Set to...
an Icon

... the Current "Transparent Color" used to Paint 
(the little apostrophe mark will remind you)

a Bitmap
... the Current Right Button "Foreground Color" 
used to Paint (like any other Drawing App.)



    Paint Tools
Back to: Editor Main Topic

Select a Tool
Click a Tool Button, or Click Tools  [Tool], or Press the appropriate Hot Key.

Paint...
Use the Left Mouse Button to Paint with the Left Color, the Right one to Paint with the Right Color.

Undo/Redo...       [CTRL+Z]
 All Paint Operations (except Pick) will Enable this Button. Click it to Discard the Change, and Click it again to re-

Display it (REDO). 

The Undo To Image at Upper Right is Updated each time you Click on a New Tool (including Move, but excluding the
Magnifier): Double-Click it to revert to that State, or Click Undoes  Undo to Undo to Image.

If you have really messed up, Click Undoes  Reload Original Image (or New Template).

     Pick a Color        [CTRL+I]
Use the Left or Right Button to Pick a Foreground Color from the Editing Area. Disabled for Monochrome Images, 
and when the "Transparent Colors" Option is selected (Icons only).

    Draw       [CTRL+D] 
Paints individual pixels
1  Click in the Editing Area
2    Release the button: UNDO Last is updated.

Draw more than one pixel:
Drag the mouse slowly before releasing the button. 

    Line       [CTRL+L]
Paints a one-pixel wide line. 
1    Click in the Editing Area to anchor one end of the Line
2    Drag the mouse until it reaches the other end of the Line you want to draw
3    Release the button.

    Fill       [CTRL+F]
Fills a closed area.    
Click in the region to be Filled: all adjacent pixels which are the same color as the starting pixel will be colored 
automatically.
MORE ON:    QuickTran Fill (256 Colors or more).

    Swap Two Colors        [CTRL+W]
Quickly Replace one Color with another.
1    Select the two Colors you want to use (Icons: Select both as Foreground)
2  Select the Size of the Swap (Color Replacer) Tool
3    If the Size is higher than 1 pixel, Select the Brush Style: Round or Square
4    Place the Cursor where you want to Start Replacing a Color.
5    Press    the Left Button to Start Replacing the Right Button Color with the Left one, or vice-versa. 
6    Move the Mouse to continue Replacing the Color.
7    Release the Mouse Button when you are done.



 
Swap with Transparent:

If you Edit an Icon, you can Swap the Left Foreground Color with the Transparent one if you Select the 
"Alternate Colors" Option. 

    Rectangles and Squares
Paints a Rectangle or a Square.    Click the Arrow Button to Fly-Down    all 3 Styles. 
1    Click in the Editing Area to anchor one corner of the rectangle
2    Drag the mouse until it is the size and shape you want
3    If you want a "Purrfect" Square, Press the CTRL Key while Dragging
4    Release the button.    

    Ovals and Circles 
Paints an Oval or a Circle. Click the Arrow Button to Fly-Down all 3 Styles. 
1    Click in the Editing area to anchor one point of the circle
2    Drag the mouse until it is the size and shape you want
3    If you want a "Purrfect" Circle, Press the CTRL Key while Dragging
4    Release the button.

    Text        [CTRL+T]
Opens the Text Tool.



    QUICKTRAN Fill
Back to: Editor Main Topic

Quickly Creates Transparency in Icons that don't have a uniform color as background, but have similar ones.    

Visible if...
.    You Edit an Icon with 256 Colors or more
.    The Fill Tool is Selected
.    The "Transparent Colors" Option is Selected

How to do it

Adjust the RGB Tolerance Scroll (Range is 0-100), then Click a Pixel in the Editing Area:    any pixel whose RGB 
levels are close to those of the Clicked Pixel will also be changed to Transparent.      

TIP: Start with a Low Tolerance value near the Image you want to keep, then increase the value as you get closer 
to the borders.

RGB Tolerance
BMPTOICO looks for pixels whose Red, Green and Blue values differ from those of the Clicked Pixel within the 
Tolerance Range you have set, plus or minus.    Since the RGB levels have a Range of 0-255, QuickTran works 
only for colors that are similar.

Example:

In this Icon, the Dark Green RGB values are 37-121-0 respectively, and the Light Green ones are 73-220-0.    An 
RGB Tolerance of 100 was needed to make both Greens Transparent when one Green Pixel at the right of the cat 
image was Clicked with the Fill Tool.



    Text Tool
Back to: Editor Main Topic

    Open it...
Click the Text Tool Button, or Click Tools  Text, or Press [CTRL+T].    

The Text Frame will open at the right of the Editing Area. If your    Image has 256 or True Colors, the Big Palette(s) will
remain available. When the Function opens, you will see the Text Cursor at upper left of the Editing Area.    Click 
anywhere in it to re-position it, or use the Move (Arrow) buttons.    Each time you change a Text Attribute or Position, 
you can see it immediately in the small Image, as well as in the Editing Area.    

1      Enter some Text
Type your Text in the Box, one line at a time. If you Add a Line, the previous one cannot be modified anymore. 

Each line being independent from the other means that you can use more than one Color or Font in the same 
Image. 

2      Change its Color, Position, Font
Use the Tabs:    Color/Position,    Font

All the Text Attributes (Font, Font Size, Color, Bold, etc...) are kept in memory until you exit BMPTOICO.

3      Use the Buttons to...
Er[ase]          

Deletes the Text from both the Image and the Text Box (same as Deleting the Text in the Box).

Ad[d    Line]
The new line is positioned below the previous one, which is now part of the Image. 

Tips
.    If you don't see the New Line, Move it up until you see it, or Click in the Editing Area to re-position it.
. To get characters of different colors in one line, enter each one as a separate Line, and move it to the correct 

position. 

4      OK, Done...
Click the Text OK Button to close the Text Function and return to Editing, or Click the Cancel button. And if you 
Click OK by mistake, you can still Undo all Text changes by Clicking the Editor's UNDO Button.
          



    Text: Color/Position
Back to: Editor Main Topic

This Text Tool Tab allows you to Change the Text's Position and Color. If you are Editing an Image with 256 or True 
Colors, the Big Palette(s) remain available.

Text Position
Move (Arrow) Buttons
Click them to move your Text (or the Text Cursor) around, one pixel at a time. You can also quickly Change the 
position of the Text by Clicking in the Editing Area.

H    V    Buttons
Click them to Center your Text Horizontally between the Left and Right Margins, or Vertically between the Top and 
Bottom Margins. 

Text Color
The Text's Small Palette is a copy of the Editor's Small one. Click on a Color in it or (if available) in the Big Palette; 
the current Color is displayed above the Small Palette.

If you want the Text to be Transparent, Check the Box at the upper right of the Palette (Disabled if you Edit a 
Bitmap).



    Text: Font
Back to: Editor Main Topic

This Text Tool Tab allows you to Change the Text's Font, its Size and its Attributes. You can also Manage your 
personal Font list, and quickly add non-standard characters to your Text.
Name

Select a Font from the Combo list. When you first run BMPTOICO, the list contains Fonts common to all version of 
Windows. You can modify it by Clicking the Fnt Mgr Button (see below).

Size
Use the Scroll to change the Point Size of the Font; some Fonts have a limited range of Sizes.

Attributes
Click the Buttons to set these Attributes On or Off: Bold (default is On), Italic, Underline, All Upper Case (default 
is On).

Character Map
Click the Char Map Button to Open it. Displays all characters in the Font currently selected in the Text Function: 
especially fun to use with "Ding" Fonts, which are displayed in a bigger size. 

To Add a Character to your Text
1 Click it to highlight it
2    Click the Select button to copy it to the Map's Text Box; you can Select more than one character
3    Click the Paste button to Close the Map (or Cancel).

If the Font Tab's UC Button is down, the Map automatically converts all characters to Upper Case. 

Font Manager
Click the Fnt Mgr Button to Open it. The Fonts currently used by BMPTOICO's Text Function are listed at Left, and
all the other Fonts on your system are listed at Right. Use the << and >> Buttons to Add or Delete Fonts from 
BMPTOICO's list. This list is kept in the INI file, and BMPTOICO will check for bad fonts each time it starts.



    Magnifier Tool
Back to: Editor Main Topic

Use the Slider to Zoom In on the Image for easier Editing. Or Click Tools  Magnify, and Select a Magnification 
Factor.

Zoom In Move the Slider Down
Zoom Out Move the Slider Up
Reset to
          No Zoom

You can also Double-Click the Magnifier area, 
or Click Tools  Magnify  Normal

Current Magnification Factor

It is always displayed below the Editing Area, at the right of the Image Specifications. 

The Maximum Factor varies according to the size of the enlarged pixels in the Editing Area (the smaller they are, 
for example if your Image is 72x72 pixels, the more you can Zoom In).



    Image Menu
Back to: Editor Main Topic

Check Transparency
Same as the Check Transparency Button. Displays the Icon's Mask in the Editing Area, showing which pixels will 
be Transparent.    Disabled if you are Editing a Bitmap. 

Test the Cursor...
Same as the Test the Cursor Button. Visible only if you are Editing a Cursor. Opens the Test Cursor form.

Save as...           [CTRL+S]
Same as the Save Button. Enabled only when you have modified the Image or a Palette. Saves the Current Image
with any modification to the Image done in the Editor so far. If you have Edited a 256-Colors Image's Palette, it will 
be updated at that point and saved with the File.
MORE: Save a File

Zoom on Other Formats
Visible only if the Icon you are Editing has more than one Format. Useful to compare Colors, Design, etc. Opens a 
Small Form with the Picture List of all the other Formats in the Icon: Select the one of which you want to see a 
Blowup.

Picture and more help:
How Do I... Compare the Image I am Editing with Other Images?

ClipBoard Viewer
Shows the Bitmap (Icons are always copied as Bitmaps) currently in the Clipboard, with its pixel dimensions, or a 
message if there is none. This function is also accessible from the Global menu of the Main form.

Show ClipBoard to Compare
Visible only if your Video Mode is High Colors or more. Displays the Contents of the ClipBoard in a special Form 
that will stay on your Desktop for as long as you need it.    This function is also accessible from the Global Menu of 
the Main form.

Picture and more help:
How Do I... Compare the Image I am Editing with Other Images?

Cancel
Same as the Cancel Button. Exits the Editor, discarding any modification to the Image or the Palettes. If you have 
Saved from the Editor, this will only Cancel the modifications done after the Save.

Done
Same as the Done Button. Exits the Editor and returns to the main form with all the modifications to the Image or 
Palettes.



    Tools Menu
Back to: Editor Main Topic

This Menu's items perform the same operations as the Tool Buttons.

Tool Action Key see...
Move [CTRL+M] Move Tool
Text [CTRL+T] Text Tool
Magnify Magnifier Tool
Pick Color [CTRL+I] Paint: Pick Tool
Draw [CTRL+D] Paint: Draw Tool
Line [CTRL+L] Paint: Line Tool
Fill [CTRL+F] Paint: Fill Tool
Swap Colors [CTRL+W] Paint: Swap Tool
Rectangle/Square Paint: Rectangle Tool
Oval/Circle Paint: Oval Tool

Like their Button counterparts, Rectangle/Square and Oval/Circle offer 3 Styles.



    Edit Menu
Back to: Editor Main Topic

Enabled only when you Select the Move Tool.

Commit Selection
Commits the Change to the Image. Same as Clicking outside a Selected Region or Clicking the Commit Selection 
(Ö) Button.

Cut | Copy            [CTRL+X] [CTRL+C] 
Same as the Cut and Copy Buttons, with same Enabling remarks.

Delete                          [Del]
Deletes the Selection from the Image, without Sending it to the ClipBoard.

Select All             [CTRL+A]
Selects the whole Image; Disabled if a Region is currently Selected.

Paste Opaque | Transparent          [CTRL+P] [CTRL+V]
Same as the Paste Buttons: see Pasting.

Nudge... Left | Right | Up |    Down see Nudge Button
Flip... Horizontal | Vertical see Flip Button
Rotate... Left | Right see Rotate Button



    Undoes Menu
Back to: Editor Main Topic

Undo/Redo Last          CTRL+Z
Same as the UNDO/REDO Button. Enabled each time you use a Paint Tool (it will work both ways until you 
perform another operation), Disabled if no reversing can be done.    If you are using the Move Tool, only one Undo 
Last is permitted (no Redo).

Undo to Undo to Image 

Resets the Edited Image to that of the "Undo To" Image at the upper right (Updated each time you Select a new 
Tool or if you Change the Transparent Color). You can also Double-Click the Image itself.

This item, and the Image, are disabled if the Edited Image is identical to the Undo one, or when you Check an 
Icon's Transparency.

TIP: if you wish to Update this Image while continuing to use a Tool, select another one, then re-Select the one you
need. 

Zoom on Undo to Image 
Shows a Blowup of the "Undo To" Image.

Reload Original Image
Reloads the original Image from BMPTOICO's main form, discarding any modification to the Image or Palettes: 
you will be reminded, and asked to Proceed or not. If you have Saved the Image from the Editor, it will Reload the 
Image that was Saved.

If you Edit a New Image, the menu item will read "Reload NEW Template" and Clicking it will Clear the Image. If 
you Save the Image in the Editor, the "Original Image" will be updated.



    Options Menu
Back to: Editor Main Topic

These Options are all Toggles, and will be saved to the INI file when you Exit BMPTOICO. They slow down the 
display slightly, so you might want to turn them Off if you are working on a slower computer.

No Grid | Black Grid | Grey Grid
You can display a Pixel Grid in the Editing Area, or not. If your Image is dark, select the Grey Grid. Default is No 
Grid.

Transparency Dots 
Shows which Pixels are Transparent in an Icon with small dots or slanted lines. Default is On (see the Editor's 
Picture for an example).    Disabled when you Edit a Bitmap. 

RGB values     No Show | Decimal | Hexadecimal
Displays the RGB Values, and a Color Swatch, currently under the Mouse Pointer.    Works over the Editing Area 
(Foreground Colors only), the Color Options, the Palettes, and the "Mix" Palette if present. Default is On and 
Decimal.
 
Note: The RGB Values are not visible when the Move Tool is Selected.



Convert a File

Open the Wizard
Click the Convert > Button, or Click File  Convert >, or press [CTRL+C] or [ALT+C].

Button and Menu item are labeled according to the Opened Image, not its extension (if the Opened .ICO file is really 
a Bitmap with an .ICO extension, the Convert button is labeled "> ICO"). 

Two Versions

 BMP > ICO   Wizard      

 ICO > BMP   Wizard      

Wizard Navigation
Click the Next or Back Buttons. On the last page, the Next button will be replaced by a Convert button. When you
Click it, the Converted File will be Saved to the Current Save Folder (same as the Current Open Folder, unless it is
Read-Only) and automatically Opened into BMPTOICO. You can, at any time, Click the Cancel button.

More Conversion Options
See Save a File for more specialized Options (like changing only the extension).

A Note on File Names:    
The last page of the Conversion Wizards allows you to change the default filename; it might be the only page 
shown (for ex. if an Icon has no Transparency, you cannot change its Background color when converting it to 
BMP).

The default file name will be the same as that of the Image in the Main Form, but without the target extension, 
which will be added automatically.    For example, if you Convert BALLOON.ICO to BMP, the default file name will 
be BALLOON, but it will be saved as BALLOON.BMP.    



    Convert: BMP to ICO
Back to: Convert a File

1      Select the Color Depth
This page appears only if 
. Your Video Mode is set to High or True Colors
. The Bitmap you are Converting has True Colors

The Options are True Colors or 256 Colors (Default), and BMPTOICO shows you both Images (the 256-Colors 
Image's Palette is built when you Click the Convert Button, from a range of colors found in the Image).

How can I use 256 Colors Icons?
Are True Color Icons used in "real life"?

2      Set a Color to be Transparent in the Icon
This page, always shown, lets you set a Color that will be Transparent in the Icon. Your Bitmap is Displayed at 
left, the future Icon's Mask at the right.

Click on a Pixel of the Color you want to be Transparent, check the result in the Icon's Mask at right and in the 
Small Icon at bottom. If you don't like it, Click the Reset to:    NO TRANSPARENCY Button: the Mask will revert 
to All Black.

NOTE: ALL Pixels of that Color will be made Transparent in the Converted Icon. You might need to first Edit your 
Bitmap to make sure this Color is not used anywhere else in the Image.

MORE ON:  Transparency

3      Set the Target FileName
The last page of the Wizard allows you to change (or accept) the default filename for the ICO Target file.

[Convert] > CURSOR
If the Bitmap you are Converting from measures 32 x 32 pixels, Check the box at the lower left to Convert it to a 
Cursor.

4      Select one or more Formats for the Icon
If the Bitmap's size is one of the three 32-bit Windows preferred Formats, you can save additional Formats in the 
ICO file while Converting:



In the Save Filename page of the Wizard, Check the format(s) you wish to add to the Icon (you need to preserve 
the current Size of the Bitmap: its CheckBox will be greyed).

5      Convert 
Click the Convert button to complete the operation, or click the Cancel button if you change your mind.



    Convert: ICO to BMP
Back to: Convert a File

If your Icon has Transparent Pixels, they will be Converted to Foreground Pixels (Bitmaps don't know about 
Transparency) of BMPTOICO's Current Transparent Color, but you can change that Color before the Conversion. 

1      Select the Background Color
This page is shown only if your Icon has Transparent Pixels. Click a Color on the Palette: the little image shows 
you the result. You may Click the Zoom+Tran button to see result in detail.

Palette offered

, 
,
 That of the Image.

 Windows' Standard 256-colors palette; since your System is set to High or True Color, all Colors will be OK in 
the Converted BMP.

How can I tell if my Icon has Transparency?
The Zoom Button's picture in BMPTOICO's Main Form will tell you:     Yes      

 No
MORE ON: Transparency

2      Set the Target FileName
The last page of the Wizard allows you to change (or accept) the default filename for the BMP Target file.

3      Convert 
Click the Convert button to complete the operation, or click the Cancel button if you change your mind.



Save a File

By design, BMPTOICO only has a "Save As.." Option: I found it too easy to Save a modified Image over a perfectly 
valid one that I wanted to keep...

Open the Wizard
Click the Save as... Button, or Click File  Save, or Press [CTRL+S] or [ALT+S]. 

The Caption changes according to the situation (Extracted Icon, Thumbnail, etc.).

Button and Menu item are Enabled only if you have modified the Opened Image, or if you can Save it immediately 
with a different extension (see below). It will also be Enabled as soon as you Open an Icon that contains more than 
one Format, to allow you to Save (Extract) a single Format.    

You can also Save from the Editor
Click the Save Button, or Click Image Save, or Press [CTRL+S]. Enabled only after you have painted 
something, or Edited a Palette.

Current Open Path is Read Only...
If the Current Path is on a Read-Only Drive, the Saved File will be Saved there, and you will be asked if you want 
to move to that Folder or not.

Multi-Format Icons
If the Icon has more than one Format and you have modified at least one, the Save Wizard will first offer two 
Options:

. Extract Format n Only    Saves only the Currently Selected Format to the File.

. All Formats [n]    Saves all Images to the File, with any change you have made.

File Names
When you Save a File, BMPTOICO will offer you a default filename (or nothing if it is a New File). You may of 
course change it.

Some default Save file names will have a few more characters to make them slightly different from the original file 
name; this is done to avoid overwriting valid pictures:

_Fn: Icons Extracted from Multi_Format Icons
_CR: Cropped Images
_TH: Thumbnails
_UP _DN    _DI: the Buttonizer's three States

 If the original Filename has too many characters, BMPTOICO will trunk it, to keep its total length (including the 
suffix) as 8 characters.

More "Converting" Options with Save:
Additionally, when you Save certain Files, a special CheckBox is Visible at the lower left of the Save Wizard: 

 If Your Image is...  You may Check the Box to Save it....
a 32 x 32 Icon ...as a Cursor (.CUR extension)
a Cursor ...as an Icon (.ICO extension)
a Bitmap ...with an .ICO extension (it will still be a 

Bitmap)
a Bitmap with an .ICO 

extension
...with a .BMP extension (32-bit only, see FAQ)



Menus and Buttons (Main Form)

Most of BMPTOICO's Functions can be accessed via a Top Button or a Menu, but some can only be accessed via a 
Menu. 

Menus and Buttons:
File Global

ALL...
Special Topics:
New
Resize
Edit
Convert
Save As...
Test the Cursor
Add a Format
Delete a Format

ALL...
Special Topics:
View All
Icon Extractor
Grab from Screen
Desktop Simulation

Menus only:
Color Depth Special Effects Help
ALL... ALL...

Buttonizer 
ALL... 



File Functions (All)

If no Image is Opened, only "New" and "Exit" are available. Others will become available as soon as you Open an 
Image.

    New            [CTRL+N]
Opens the New Image Wizard. If the Current Image has been modified, you are asked if you want to Save
it.

    Synchronize w/Folder (Toggle)
. Up State (Default): Changing the Folder means that the Opened Image will be Unloaded; if it 

has been modified, you will be asked if you want to Save it first.    The Button will be Reset, and 
the menu item Checked, each time you Open/Create an Image, or when you Save or Convert 
your Image.

. Down State: Changing the Folder will leave the Opened Image in memory. When you Save or 
Convert it, it will be Saved to the new Folder, not its original one, so be extra careful with that 
Lock! 

Hot Keys Opens the...
Edit [CTRL+E] | [ALT+E] Editor
Convert [CTRL+C] | [ALT+C] Conversion Wizard
Save as... [CTRL+S] | [ALT+S] Save Wizard

    Zoom            [CTRL+Z]
Shows a Blowup of the image.

If your Icon has Transparent Pixels, the Button's picture will be . In the ZOOM Form, Click the Transp. 
Button to see them.    

If your Image is a Cursor, the Transparent Image will also show it's Hot Spot.    If the Cursor does not have any 
Transparent Pixel, the above Button is re-labeled "Hot Spot".

    Palette
Shows all Colors in the Image's Palette. Click on a Color to get its RGB values. Disabled if the Image is True 
Colors (it does not have a Palette).

The RGB values might be slightly off: Why does 16-bit Video Mode not Display Colors correctly?

    Resize
Opens the Resize Wizard. Disabled for Cursors (they can only measure 32x32 pixels).

    Copy to Clipboard
Sends the Current Image to the Clipboard as a Bitmap (including Icons). To Check what was sent: Click 
Global  ClipBoard Viewer, or Image 

 ClipBoard Viewer in the Editor. You can also use the ClipBoard to display a copy of an Image while you work on 
another: Click Global    

 Show ClipBoard to Compare (or equivalent item in the Editor' s Image menu).



    Unload Current Image     [CTRL+U]
Unloads the Image from memory (Closes it). If the Image has been modified, you are first asked if you want 
to Save it.

 Test the Cursor
Opens the Cursor Test. Visible only if the Opened Image is a Cursor (the Button is then also available in the 
Editor).

The following three items are Visible only if you have Opened an Icon (MORE ON: Multi-Format Icons).

    Add a Format
Allows you to Add a Format to a an Icon file. 

    Delete Current Format
Allows you to Delete the Current Format from a Multi-format Icon.

Format List
(No Button; Visible only if the Icon has more than one Format)
Lists all Formats in a Multi-Format Icon, same as the Icon List at the right; Select the one you need.

    Exit            [ALT+F4]
Exits BMPTOICO.    If the Current Image has been modified, you are asked if you want to Save it.



 Resize Wizard
Back to: File Functions (All)

Quickly change the dimensions of the Opened Image. Button and Menu item are Disabled for Cursors, which can 
only measure 32 x 32 pixels.

 Picture with PopUp Help

1      Select the Size
Choices: 16x16, 32x32, 48x48, 64x64, 72x72 [, Custom]
The Size of the Current Image is always Disabled.

If your Resize a Multi-Format Icon, the Sizes currently used for the same Color Depth are Disabled (for ex.: if you already have 
a 16x16x16 cols format, you cannot Resize the 32x32x16 cols Format to 16x16). Also, since for Windows, 256 or True colors 
are interchangeable, both Sizes will be Disabled/Enabled together.

Custom Size    (Bitmaps only) 
Use the Scroll to change the Size, the range being 16 x 16 to 72 x 72. 

Keep Aspect Ratio: the Box is Checked by Default.    Un-Check it to Resize Width and Height independently 
with two scrolls for Width and Height.

2      Fit to Size... or not

If New Size is... Fit Action

Smaller Yes Image is Shrunk (Reduced)
        than current No Use the Crop Scrolls to show exactly what 

you wish to see

Bigger Yes Image is Blown (Stretched)
        than current No You may Center the Image, or not. 

If the Image is a Bitmap, you can Change 
the Margins'    Color (the palette is VGA16, 
or the colors closest to it in the Image's 
Palette)



Resize Wizard: Picture
Back to: File Functions (All)

(Click on elements of the picture below for more information)



 Test the Cursor
Back to: File Functions (All)

Only available for Cursors. Allows you to Test it, and View/Change its Hot Spot.

Open it...
In the Main Form or in the Editor, Click the Test Cursor Button, or Click File  Test the Cursor in the Main 
Form, or Image 

 Test the Cursor in the Editor.

It offers dummy Controls, with their individual Pointers set to the tested Cursor. Click the Label at the bottom to test
the Cursor on the Form itself.

BMPTOICO can only display Monochrome Test Cursors; if your Cursor has more than two Colors, its Original 
Image will not be changed:

(Click on elements of the picture below for more information)

The Cursor's Hot Spot
In order to be useful, a Pointer needs to have one Pixel (and only one) defined as the "Pointing" Pixel.    This is 
called the "Hot Spot", and you can change it in the Cursor Test module.

 Click the Hot Spot Button.

You will see a Blowup of the Cursor, with its Current Hot Spot colored in Red; its Pixel position is also given.    Change
it by Clicking on your new Pixel Hot Spot, and Click the Test Again button to Test your new Hot Spot.

Test completed
Click the Close button to return to BMPTOICO's main form or Editor.



 Add a Format to an Icon
Back to: File Functions (All)

You can Add Formats to any Opened Icon, if it is Square, and its Size is that of a regular Windows Icon (16 x 16, 32 x
32, 48 x 48, 64 x 64, 72 x 72); Disabled otherwise.

MORE:    What are Multi-Format Icons?

Open the Wizard...
Click the Add Format Button, or Click File  Add a Format. 

 Picture with PopUp Help, and a note about the Options offered.

1      Select a Color/Size Combination
The image at left will reflect your size choice, and will warn you if the Image's Colors need to be Decreased. 

You can Add Formats until all Combinations of Size and Color Depth possible for your current Video Mode are 
present (Sizes of 64x64 and 72x72 are not currently used by Windows, but you never know the future...).

 
Cursors
Since they need to measure 32 x 32 pixels, the Add Format Wizard only offers the Color Options.

2      Use the Current Image... or not
Most of the time, you will want to Use the Current Image for the New Format, and the CheckBox will be Checked 
then the Wizard opens. Un-Check it if you prefer your new Format to be blank.

Palette notes
.    Use Current Image:    If your Icon already has more than one Format, make sure that the Format Currently 

Selected when you Click the Add a Format button has at least the same Color Depth as the New Format you 
wish to Add. 

.    Don't Use it, : If both the Current and New Formats have 256 Colors and you have Un-Checked the Box,
you may choose a Palette: that of the Current Format, or Windows' generic.

.    Use Current Image is Mandatory for a New "256 Colors" Format (the Check Box will be Greyed), as you 
cannot Edit the New Format.

3      OK, Done
When you Click the OK button, the Editor will open automatically. If the New Format's Color Depth is less than 
the Current one, it will be Decreased before the Editor opens. You can also Cancel the New Format Wizard.

If you Click OK and then Cancel Editing without Saving the Icon in the Editor, you will be asked if you also want 
to Delete the new Format when BMPTOICO returns to the main form.



Add a Format: Picture
Back to: File Functions (All)

(Click on elements of the picture below for more information)

 

Options offered
When the Wizard Opens , it analyzes the Formats already in the file and Disables the Option combinations that are
already present. 

Since for Windows 256-colors and True Colors Formats are interchangeable, if one combination is present, the 
other one will also be disabled (for ex., if you already have a 48x48x256 Format, the 48x48xTrue combination will 
be disabled; you can always change the Format's Color Depth in the main form later).    

The Color Options available are also function of your System's Video Mode.



 Delete Current Format from an Icon
Back to: File Functions (All)

If your Icon has more than one Format, you can Delete them one by one, until only one is left. Button and menu item 
are Disabled if the Icon has only one Format.

1      Select the Format to Delete
Make sure the Format you wish to Delete is Currently Selected

2      Delete it
Click the Delete Format Button, or Click File     Delete Current Format. You will be asked to confirm the 
operation.

 

 



Global Functions (All)

Always available (except if mentioned otherwise below), whether an Image is Opened or not.

    View All                                  [CTRL+V]
Opens the View Al module.

    Icon Extractor           [CTRL+I]
Opens the Icon Extractor module.

  Grab from Screen          [CTRL+G]
Performs a Screen Capture, from which you can Crop a smaller Image.

    Desktop Simulation (Toggle)         [CTRL+D]
Displays the Desktop Simulator. Enabled only if an Icon is Opened.

The following Items in the Global Menu don't have equivalent Buttons:

ClipBoard Viewer
Shows the Bitmap (Icons are always copied as bitmaps) currently in the Clipboard, with its pixel dimensions, or a 
message if there is none. This function is also accessible from the Image Menu of the Editor.

The Colors of the ClipBoard Contents may be wrong if its Palette is not the same as that of your Opened Image.

Show ClipBoard to Compare
Visible only if your Video Mode is High Colors or more. Shows the Contents of the ClipBoard in a special Form that
will stay on your Desktop for as long as you need it.    This function is also accessible from the Image Menu of the 
Editor.

Picture and more help:
How Do I... Compare the Image I am Editing with Other Images?

New Folder
Creates a New Folder (Directory)    under the Currently Opened one. The new Folder name is restricted to eight 
characters by BMPTOICO. This item is Disabled if the Current Folder is on a Read-Only Drive.

Refresh Lists             [F5]
Refreshes both File Lists. Useful if you have done some Folder management outside BMPTOICO. 

Preferences...
You can set a few Preferences in BMPTOICO:

. Display Tool Tips
Display Tool Tips at lower left in the Main Form as well as in the EDIT, VIEW ALL, ICON Extractor and Crop 
Modules.    Change is immediate. Default is: Display them.

. Open to Last Folder Used
By Default,    BMPTOICO opens at the Last Folder you have used (or to its own Folder if the Last Folder was on 
a Floppy or Read-Only Disk). If you don't like this, you can ask BMPTOICO to disregard the Last Folder Used. 
The Change will take effect the next time you Run BMPTOICO.



    View All
Back to: Global Functions (All)

View All Icons, Cursors, BMPs and Metafiles in the Current Folder. Disabled if there are no Images in the Current 
Folder, or only Web files (which cannot be Viewed).

Open it...

Click the View All button, or Click Global  View All, or Press [CTRL+V].    

The module opens    with Thumbnail Icons (or Bitmaps if there are no Icons in the Folder) on the left.    The Total 
Number of Icons or Bitmaps in the Folder is displayed in the form's Title bar.    Each image has its File Name, 
Dimensions and Color Depth (or some other information) displayed under it. 

 Picture with PopUp Help

Limitations
The module relies on Windows to Display the Images, so it cannot View... All Files, and does not View many of 
them properly: Why can I "View" an Image, but not Open it? Or vice-versa?.

1      Select an Extension
Icons (includes .CUR Files) 

Up to 20 per page; all are shown as 32 x 32 pixels Thumbnails, or Actual Size if they are smaller. If the Icon has
more than one Format, the Thumbnail displays only the first one.

Bitmaps (includes .WMF Files) 
Up to 15 per page; all are shown as 72 x 72 pixels Thumbnails, or Actual Size if they are smaller. (Web files, 
which cannot be Viewed, are not displayed).

Information about each Image is displayed below it.
 BMPTOICO truncates File Names that are too bit fit below the thumbnail. When you Select such an Image, the 

Full Name will be displayed at the bottom right of the module.

2      Select an Image
Click on an Image to Highlight it; its number (in the Folder) is displayed at right, under the Scan buttons.

3      Navigation Buttons
(Disabled if there is only one page).
Scan

To turn the pages.
Search

Enter an Image Index Number (in the Folder, see Information under the Scan Buttons), or the beginning of its 
File Name (this can be only one character: Enter "m" to quickly get to the first Image which filename starts with 
"m").

4      Right-Click on the Image to Pop the File Menu

Info
Information on the Disk File.

Zoom 
Shows a Blowup of the Image as displayed in the VIEW module or, if it measures more than 72x72 pixels, the 
Image in Actual Size. Disabled is the Image is not valid.    

Open 
Same action as the Open Button. Enabled only if the Image can be Opened in BMPTOICO.

Delete |    Rename
Deletes or Renames the Currently Selected Image File in the Current Folder. Not Visible if the Current Folder is
on a Read-Only Drive.

 
5      OK,    Open...

Click the Open Button, or Select "Open" in the File menu (Button and Menu item are Disabled if you can't Open 



the Image in BMPTOICO).    You can also Cancel the View All Module.

 



View All: Picture
Back to: Global Functions (All)

Left Portion: 
(Click on elements of the picture below for more information)

 

Right portion:
(Click on elements of the picture below for more information)



    Icon Extractor
Back to: Global Functions (All)

BMPTOICO will let you Extract Win 3.x Icons from Executable (or similar) Files, or Icon Libraries.

Open it...

Click the Icon Extractor Button, or Click Global  Icon Extractor, or Press [CTRL+I]. 

The Extractor module    offers two File Lists: they open to the Current Folder in BMPTOICO, but you can navigate 
your drives independently in the module. 

 Picture with PopUp Help

Painless Extraction
1        Find a File

2        Find an Icon

File Types    
Left File List extensions Right List extensions 
.EXE    Applications .DLL Executables/Libraries 
.CPL Control Panel applets .ICL    Libraries
.DRV Drivers .NIL    Libraries
.SCR Screen Savers
.VBX Visual Basic Components
.OCX ActiveX Components

You can Modify these Lists... 
Select the File Types... Menu. In the FILE TYPES Form, Check or Un-Check the extensions you want to see, then
Click the OK button. The modified List is immediately saved to the INI file. and will be used until you Modify it 
again.

To see which Types are Currently Selected
In the Icon Extractor Form, move the Pointer over the File Lists to see the Current Types in the Tool Tip.

Limitations
Being a 16-bit Application, BMPTOICO can only Extract Win 3.x Icons (32 x 32 pixels), but it will Extract Icons with 
more than 16 Colors if your Video Mode is set to High or True Color. If an Icon is Multi-Format, it will Extract only 
the first 32 x 32 Format it finds.

Bad Icons are represented by a big X Icon, and cannot be Opened.



    Icon Extractor: Picture
(Click on elements of the picture below for more information)



Icon Extractor: Find    a File
Back to: Global Functions (All)

The Icon Extractor has its own Drive, Directory, and File Lists. They are set to the Main Form's Current Folder when 
the Module Opens, but you can Navigate your Drive independently afterwards.

 Long filenames are used. To Change the Width of the Folder or File Lists, move the mouse pointer over the Dividers between 
the Lists, Click a Mouse Button and Drag it.

1      Select a Folder
If a File is already Opened, it will be Closed when you Select a new Folder. You can List only Files with Icons 
(Check the Box at the Lower Right), but this takes longer.

2      Select a File
Click on a FileName to Highlight it.

3      Right-Click the Highlighted File to Pop a Menu
Info

Information on the Disk File.
Open

Enabled only if there are Icons in the File. Same a Double-Clicking the File Name.

4      Open the Highlighted File
Double-Click on a FileName to Open it (BMPTOICO will Beep if there are no Icons in the File), or Click [File 
PopUp]  Open. The first 27 Icons in the File will be shown. The Total Number of Icons in the File is displayed
in the form's Title bar. 

Continue to Find an Icon 



Icon Extractor: Find an Icon
Back to: Global Functions (All)

1      Select an Icon
Click on an Icon to Highlight it;    its number (in the File) is displayed at right, under the Scan buttons. 

Icon Name
If the Library uses Names, that of the Selected Icon is displayed at upper right. If it not a Library, or it is but does 
not use them, BMPTOICO will use the Filename and the number to create one.

2      Navigation Buttons
(Disabled if there are only 27 or less Icons in the File).
Scan

To turn the pages.
Search

Enter an Icon Index Number (in the File: see Information under the Scan Buttons), or the beginning of its Name 
if the File contains Names (this can be only one character: Enter "m" to quickly get to the first Image which 
filename starts with "m").

3      Right-Click an Icon to Pop the Icon menu
Zoom

Shows a BlowUp of the Icon.
Open

Same a Clicking the Open button.

4      OK,    Open...
Click the Open Button, or Click Icon  Open (also in Icon PopUp menu) to send the Icon to BMPTOICO's 
Main Form.      You can also Cancel the Icon Extractor.

Color Check
BMPTOICO will check to see if the Icon contains only the VGA 16 Colors; if it finds at least one color that is not 
part of this palette, the Extracted Icon will have a 256 Color palette in BMPTOICO.

Change Folder
If the Folder from which you Extracted the Icon is not the same as the Currently Opened Folder in BMPTOICO, 
you will be asked if you want to Move to New Folder Path.

Back to:    Find a File



    Grab from Screen
Back to: Global Functions (All)

If the Image you want to use in BMPTOICO is Displayed in another Application, or you want to get an Icon from your 
Desktop, it is very easy.

How it works
Click the Grab Button, or Click Global  Grab from Screen, or Press [CTRL+G].

BMPTOICO will first ask if your Screen is Ready. It then minimizes itself and captures the whole Screen.    

The CROP Module will automatically open with the resulting Bitmap, from which you can Crop a smaller Image.

The Color Depth of the Bitmap will be that of your Current Video Mode, except for 16- and 32-bit Modes, in which 
case the Image will be 24-bit.

 Capture Problem?
If your computer is very fast, BMPTOICO might not have time to Capture the whole screen if the application you 
are Capturing is positioned under the BMPTOICO form and does not repaint itself fast enough.    To make sure that
you catch what you need the first time, position your target Form besides BMPTOICO if you can.

 Color Problem?
Why does the Bitmap I Grabbed from Screen have the Wrong Colors?



    Desktop Simulation
Back to: Global Functions (All)

Allows you to see your Icons or Cursors on a Simulated Windows Desktop, to better Check their Transparency.    Not 
available for Bitmaps, except those having an .ICO extension (the Simulator emulates 32-bit Windows'    Fake 
Transparency). 
 

The Simulator

Use the Scroll to Cycle through Windows' VGA 16 Palette (the Color is kept in the INI File when you Exit 
BMPTOICO). If you modify the Image by Editing it or changing its Size or Color Depth, the Simulation will be 
Updated.

The Button is a Toggle...
Once Clicked, it will stay down until you Click it again, and any appropriate Image that you Open will automatically 
be Simulated. 

 Disabled (and the Desktop Sim not visible) if the Opened Image is a Bitmap, or if you Unload (Close) an Image, 
but the Sim will reappear as soon as you Open another appropriate Image.



Color Depth Menu

You can, at any time, Change the Color Depth (Number of Colors) of an Opened Image and Preview the result.

What is Color Depth?

1      Select the New Color Depth

To Color    Depth Palette used

Monochrome 2 Colors, Black and White
16 Colors VGA 16    Palette (see it) 
256 Colors From 2 or 16 Colors: Standard

From True Colors:    Optimized, from the Image    
True Colors [None]

Count Colors Used:  See how many Unique Colors are currently present in your Image.

Limitations
. If the Current Image belongs to a Multi-Format Icon, the Color Depth Choices already present    for its Size are

Disabled.
 The 256 and True Colors Choices are Not Visible, as they are useless...

The True Colors Choice is Not Visible, You can Increase the Color Depth to 256 Colors, but No Editing is 
possible.

2      Check the Result
BMPTOICO will show you the result in a small Preview Form. Click OK if you like it, or Cancel.

3      Select another Palette if Decreasing
 
 only. If you are Decreasing the Color Depth, you can also Select the Palette; the result, especially when 

Decreasing to 16 Colors, depends on the Number of Colors in your Image (Click the "Num Cols -Main" Button to get 
a Color Count of the Original Image).

 
Decrease to... Palette Choice
16 Colors . Windows (Default)

. Optimized
Bitmaps only, since 16-Color Icons should 
always use the VGA16 Palette

256 Colors . Optimized (Default)
. Wndows Standard

4      Edit the Image with the New Palette
When you Click the OK Button in step 2, BMPTOICO will ask if you want to Edit Now?  Answer "Yes" to open 
the Editor, or "No" to Accept the New Color Depth without Editing (you can always Edit it later).



Special Effects Menu

You can, at any time,    modify the Global Aspect of an Opened Image.

Buttonize...    
Always Visible, sometimes Disabled.
Buttonizer Help 

All Other Effects...      
. Visible only if your Video Mode is set to High Color or more (No Edit otherwise)
. Enabled only if the Image has 256 Colors or more (they need a wide Color Range).
Detailed Descriptions and Help

1      Select an Effect
Select a Menu Item: The appropriate Form (SPECIAL EFFECTS or BUTTONIZER), will Open with the Original 
Image.

 
Buttonize...    See Buttonizer.

Inverse Colors |    Blur |    Grey Scale |    Web Safe Palette
These Effects Are applied automatically when the Form Opens.

Darken/Brighten |    RGB Color Balance |    HSL Color Balance
The Form Opens with the original Image. One or more Scrolls allow you to vary the Effect. Use them to modify 
the Image, or Click the Reset to 0% button to re-load the Original Image and start over. 

2      OK, Done
Click the OK Button to accept the Effect, or Cancel it. 

The Image's Palette needs to be rebuilt:
 It will be rebuilt automatically with the New Color Range.
 If you have Edited your Image before applying the Special Effect, the    Palette used in the Editor will be rebuilt 

as above.



Special Effects: List
Back to: Special Effects Menu

Inverse Colors
Negative Image produced by Inverting All the Colors. 

Blur
Blurs the Image.    All Transparent Pixels in Icons will need to be made Foreground first (Blur does not work well 
with Transparency; BMPTOICO will ask you to confirm).

Grey Scale
All the Colors in the Image will be Converted to Shades of Grey.

Web Safe Palette
All the Colors in the Image will be adjusted to the Netscape 216-colors Safe Palette, the special Palette used by 
Web browsers when users surf from a 256-Colors system.

Darken/Brighten
A Positive Scroll Value will make the Image Brighter, a Negative one will Darken it. 

RGB Color Balance
Add or Subtract the level of Red, Green or Blue in the Image. 

HSL Color Balance
Modify the Hue (Tint), Saturation ("Purity" of the colors) or Luminance (Brightness).



Special Effects: Buttonizer
Back to: Special Effects Menu

Quickly Transform any Image into a Button, or Create a New one with the New Image Wizard.

Disabled only if the Image is Monochrome (Buttons need at least three colors), or has 256 Colors and your Video 
Mode is also set to 256 Colors.

Open it...
Click Special Effects  Buttonize... 

 Picture with PopUp Help.

1      Select a Color (New Buttons only)
The palette is VGA16.

2      Select a Style
Seven Choices.    BMPTOICO always remembers the last Button Style you have used, and will keep it in the INI 
file, ready for your next Buttonizing session.

BEVELLED Style Options: 
. Size: you can change the Pixel Size of the Bevel.    Result is function of the Image's Color Depth, and whether the 

"Resize within Borders" Box is Checked or not.

. Shades: if the    "Resize within Borders" Box is Checked, you can also Select the Bevels' Shades: White (default) or
Grey for the Light Shade, Dark Grey (Default) or Black for the Dark one.

. 
Example: this 16-Colors Button has a Size of 5 Pixels; its Light Shade is White, its Dark Shade is Black.

3      Select a State
Up, Down, Disabled. The Down State can be Darkened Dark, Light, or Not.

If you need more than one State of a Button, first Save the Original image. Then, for each State:
1    re-Open the Original Image
2    Open the Buttonizer
3    Select a different State 
4    Click OK
5    Save it: BMPTOICO will add    _UP, _DN or _DI to the Default Save Filename.

4      OK, Done
Click the OK Button, or Cancel.

Some Buttons might need slight Editing, especially Disabled Buttons if you have Checked the "Resize Within 
Borders" Box (Windows might put in some unwanted Black Pixels when shrinking the Image).

 
Non-Standard Windows Color Schemes (256 or True Colors Buttons)

. New Buttons: the Button Color of your Color Scheme is added to the Palette.

. Existing Bitmaps: a CheckBox at the top of the Button Styles frame allows you to set your Button Colors to 
your Color Scheme if you wish (if the Image has 256 Colors, its palette will be rebuilt to include these colors).



Special Effects: Buttonizer: Picture
Back to: Special Effects Menu

(Click on elements of the picture below for more information)



 Help Menu

Contents          [F1]
Opens this Help File at the Contents page.

Search Help on...
Opens the Index for this Help File (same as Clicking the Search button at the top).

Resources Check
BMPTOICO is very hungry on Windows resources. You can always Check the Percentage of Free Memory 
(System, Graphics and User) you still have at your disposal. There is a similar item in the Editor's Help menu.

About
Information on BMPTOICO, and direct Internet links for Support, MyCat Software and Online Registration (this 
last link is not visible once you have Registered).    The links work only if you have an Internet connection, and 
have set a Browser as your "Default Browser" in Windows (not tested with Windows 3.1).

How to Register
Opens this File at the How to Register page.    This item is Not Visible after you have Registered.



FAQ - Frequently Asked Questions

Icons in Windows
    What is "Transparency"?
    How can I use 256 Colors Icons?
    What are Multi-Format Icons?
    How    does 32-bit Windows use Multi-format Icons?
    Are True Color Icons used in "Real Life"?
    Can I use a Bitmap as an Icon? 

Color Concepts
    What is Color Depth?
    Aren't "Video Mode" and "Color Depth" the Same Thing?
    Any Image Palette Restrictions?
    Any Windows Palette Restrictions?
    Any Treat for my Special Color Scheme?
    Why does 16-bit Video Mode Not Display Colors Correctly?

BMPTOICO's Performance
    Why can't I Edit my 256 Colors Image?
    Why can I "View" an Image, but not Open it? Or vice-versa?
    Why is BMPTOICO Slow, especially while Opening Icons?
    Why does the Bitmap I Grabbed from Screen have the Wrong Colors?
    Why are the Colors in my 16-Colors Icon all Wrong?

Miscellaneous
    Can I Open Web Files in BMPTOICO?
    Can I Open Other Graphic Files?
    How can BMPTOICO use Long Filenames?
    Is BMPTOICO "Y2K" Compliant?

See also:    How Do I... ?
                                  



FAQ: What is "Transparency"?
Back to: FAQ

.    Icons look better if they have some Transparency.

.    Cursors with no Transparency look very clumsy...

.    Bitmaps don't know anything about it.

Explain it...
Real Icons (and all Cursors) are actually special Bitmaps saved with two Pixel definitions: one for the image itself, 
with all "Transparent" Pixels set to Black, and a Monochrome Bitmap, called the Mask, with all "Transparent" 
Pixels set to White; the displayed Icon is built from these two superimposed Bitmaps:

"Screen Inverse"
If a given pixel is White in both the Image and the Mask, Windows 3.1 will interpret it as "Show whatever is under it
in Inverse Colors"; this is very seldom used, and does not    work in Win9x, but is available in BMPTOICO's Editor 
for backward compatibility.

In BMPTOICO...
To see if your Opened Icon/Cursor (or the Selected Format if it has more than one) has Transparent Pixels, look at
the Main Form's Zoom Button's picture:  Yes      

 No.    

You can also use the Desktop Simulation Function.
 



FAQ: How can I use 256 Colors Icons?
Back to: FAQ

These Icons are really intended for 32-bit Windows... and 32-bit Win Apps. 

    Win
To Display these    Icons in Windows itself (Explorer, etc.) , your Video Mode must be set to High or True Color, and
you may need to tell Windows to use them (best way to know what it can do is to    try it first...) .
 
If you have an early version of Win 95 (prior to OSR2, dated Aug. 1996), you need Microsoft's Plus! Pack (a 
commercial product) , or    Microsoft's "Font Smoother" utility (www.microsotft.com), or    Activicons 
(www.cursorarts.com). 

If you need    to tell Windows...
1    Open the Control Panel
2    Click on the Display Icon.
3    Select a Tab: labeled "Plus" in Win 95, "Effects" in Win98/2000
4    Check the Show icons using all possible colors Box

    Win
Avoid them... You can try to use them as Icons in the Program Manager: it will not crash, but the Icons will be 
Displayed in 16 Colors only. 

If you write 16-bit Applications, you should NEVER use such Icons as the Icon property of a Form.    If you do 
this, Windows will give a GPF or freeze.

          



 FAQ: What are Multi-Format Icons?
Back to: FAQ

Icon Resource files can contain more than one Icon Format. BMPTOICO can Open or Create them (see an example),
if your Video Mode is up to it (if one Format has more colors than your Current Video Mode, they cannot be Opened).

Which Formats are used? 
In theory, any... In practice, only a few Formats are of real use. A set of three 256-Colors Icons is enough:    16 x 
16,    32 x 32, 48 X 48 Pixels. Windows will decrease their Colors if it needs to display the 16 Colors version. But if
you want to really control how your Icons will look, you can include 16-Colors Formats as well.

Cursors too...?
I have never seen a Multi-Format Cursor, so BMPTOICO does not support them. If you have some documentation 
proving otherwise, please send it to me and I will include the change in a future update.

Can I use them outside BMPTOICO?

 Yes
see How does 32-bit Windows use Multi-format Icons?

    No
If you write 16-bit Applications, you MUST use One-Format only Icons,    with 16 colors (Windows Standard) 
and measuring 32 x 32 Pixels.    And your Cursors need to be Monochrome (if not, Windows will display them 
so).



 FAQ:    How does 32-bit Windows use Multi-format Icons?
Back to: FAQ

Windows will use the Format that best corresponds to the System's Video Mode, by looking at the Color Depth / Size 
combination Formats present in the Icon: 

Color Depth

Windows will use only the 16 Colors Formats; if there are none, it will Display the 256-Colors Icons with 16 
Colors only.

Windows will use the 256 OR True Color Formats if it can, but it will use only the 256 Colors Formats if both 256-
and True Colors Formats are present. 

Size

16 x 16 Small Icon at the upper left of opened applications, for 
the Desktop Taskbar, and for the Explorer if you 
Select View > Small Icons.

32 x 32 Used otherwise.
48 x 48 Most Multi-Format Icons have this Format, but I have 

not found why yet...
64 x 64 Not used... yet; BMPTOICO allows it
72 x 72 ditto

See also:
How Can I use 256 Colors Icons?
How True Colors Icons used in "real life"?



FAQ: Are True Color Icons used in "Real Life"?
Back to: FAQ

  Maybe...
Windows will not bark, but some Icon Editors will definitely crash.... As a rule, they are not recommended, as their 
Disk Files are very large. Plus, they cannot be used in Animated (.ANI) files.

Suggestion
Create or Edit your Icon in True Colors, then Decrease its Color Depth to 256 just prior to Saving it. If you are
Converting from a 24-bit Bitmap, BMPTOICO will set the "256 Colors" Option as the Default for the 
Conversion, and will use an optimized palette built from the Colors in the Image.

    NEVER ! 
Guaranteed GPF or freeze.



 FAQ: Can I use a Bitmap as an Icon?
Back to: FAQ

32-bit Windows can use a Bitmap as an Icon if its Extension is changed to ".ICO".    You can then use it in the 
Explorer as the Icon for a File Type, or for a Shortcut.    Windows will even try to create Fake Transparency around it, 
but it will still be a Bitmap, not an Icon.

Windows' Paint Application can use these Bitmap Icons. In the Open module, Select "All Files" as "Files of type" to list
them. It will save them with the .ICO extension if you add ".ico" to the File Name.

In BMPTOICO...
. They will be treated as Bitmaps internally (No Transparency, except in the Desktop Simulator). A note above the 

Filename in the Main Form will inform you of its status, and the Convert Button will be labeled Convert > ICO.

. You can Save such a File with a .BMP extension if you wish (Check the Save as a .BMP Box in the Save Wizard;
the Box is not visible if your system is 16-bit)

. You can quickly Change the Extension from .BMP to .ICO in the File List's PopUp Menu (item not visible if your 
system is 16-bit).

 



FAQ: What is Color Depth?
Back to: FAQ

Back when computer memory was expensive, programmers devised ways to store the Color information into as little 
memory (or Disk) space they could. In other words, in as few Bytes as possible. 

Knowing that...    
. 1 Bit can only be On or Off    
. a Byte is made up of 8 Bits 
. Hexadecimal to Binary conversion is easy for computers (one hex digit can define 4 bits)
. A Color is defined by its R[ed], G[reen] and B[lue] levels, each one having a value from 0 to 255, therefore 

needing three Bytes

... you can understand how we went from Monochrome to True Color, and now more.    

In the beginning... 
To save Bytes, Windows described each Pixel by referring to a Color Index in the Image's Palette (each color using
four Bytes: RGB values, plus a "flag"), which was then saved in the File. The Maximum Number of Colors (or Color
Depth) these Systems or Palettes could have was:

Bits used Colors Palette Indexes (Hexadecimal)
1-bit 2 0 to 1 (0 - 1)
4-bit 16 0 to 15 (0 - F)
8-bit 256 0 to 255 (00 - FF)

Then...
Windows got rid of the Palette system... (but Images with less then High Colors are still very much used, especially
for Icons and Cursors, which shoud never have more than 256 Colors):

Bits used Colors in Hexadecimal 
16-bit 65,536 (64K) 0 - FFFF
24-bit 16,777,216 (16 millions) 0 - FFFFFF
32-bit 16,777,216 (16 millions) 0 - FFFFFFFF

16-bit (High Color):    To fit into 16 bits (15 only are used, and not necessarily the first ones), the RGB values 
need to be squeezed into 5 bits, and converted from/to 8 bits by the Application. Since each Video Card 
manufacturer has its own way of doing this, there are Display problems... BMPTOICO tries its best, but does 
not always succeed... 

24-bit (True Color): each Pixel in the Image can finally be described by its True RGB values (8 Bits x 3, or 3 
Bytes). 

32-bit (True Color):  Since three bytes are enough for RGB, the fourth Byte is used to store a "Transparency" 
value. You need a 32-bit Display to see it (this is how some games can display "fog"). BMPTOICO does not use
it... Be careful if you Open one of those gems, it will be Saved as a 24-bit Image and will lose that precious 
extra information.



FAQ: Aren't "Video Mode" and "Color Depth" the Same Thing?
Back to: FAQ

Yes and No... and it can get confusing for Graphic beginners. And instead of "Color Depth", you might see "Color 
Resolution". 

Color Depth means the Maximum Number of Colors, usually in an Image, but it also applies to Monitor Displays.    
For the computer, both values are different: if you Open a 16-Colors Image in a Video Mode set to True Color, the 
Image will still have 16 Colors. BUT if your Video Mode's Color Depth is Less than that of the Image, the Image will 
be Displayed at the Video Mode's Color Depth: for ex., a True Colors Bitmap will be displayed with 256 Colors only if 
that is your Video Mode setting.

To avoid confusion, in this Help File...

Term Refers to Example
Video Mode Monitor Display  Colors Video Mode
Color Depth Image Colors Colors Image

See also:
What is Color Depth?
How Do I... Change my Video Mode?



FAQ: Any Image Palette Restrictions?
Back to: FAQ

Images that have a Color Depth of 2, 16 or 256 Colors have their Palette Definition (or Image Palette) embedded in 
their File as a List of RGB Color Definitions, but High and True Colors ones don't use Palettes at all: each pixel is 
defined by its RGB level values. 

       
 
Monochrome Images have only two Colors.

   

 

BMPTOICO prefers the VGA 16 Palette.    16-color Icons should 
always be created with this Palette only. If the Image has 16 
colors, but they are not Windows' Standard, they might not show 
properly in the Image, and they will be dithered in the Editor's 
Small Palette.

Some restrictions apply to 256-Colors Images' Palettes when 
you Edit Colors in the Editor.

256-Colors Images    can be Opened and Converted, but not
Edited.

No Palette in the File, you can do what you want with the Colors!
Provided your System is set to High or True Color, otherwise 
BMPTOICO will not even Open them.

See also: 
What is Color Depth? 
Are True Color Icons used in "real life"? 
Why are the Colors in my 16-Colors Icon all Wrong?



FAQ: Any Windows Palette Restrictions?
Back to: FAQ

Windows itself works with Palette Definitions for Video Modes that are less than 16-bit High Color, and even this 
Mode has problems.

Everything is reduced to the VGA 16 Palette.

Windows uses a 256-colors Palette, but can reset itself to the 
Palette of the Image that is "on top".    BMPTOICO uses that 
feature: in order to set Windows' Palette to that of a 256-colors 
Image, it will quickly write/read a temporary file containing the 
Image's palette to your hard disk. This file, named $$$PAL.DIB, 
will be deleted when you exit BMPTOICO.
No Editing of Images that have 256 or more Colors.

Windows can display up to 65536 colors (64K), but there are still 
some Display problems.

The Graphics lover's (and programmer's) dream... Windows can 
display just any color (well,.. more than 16 millions).    If you want 
to do the best work with 256-colors or more Images, and your 
system is up to it, set your Video mode to True Color while 
working in BMPTOICO. 

See also: 
What is Color Depth? 
Aren't "Video Mode" and "Color Depth" the same thing?
Why does 16-bit Video Mode not Display Colors Correctly?



,
 FAQ: Any Treat for my Special Color Scheme?

Back to: FAQ

So you prefer to work in Rose, Plum or Teal (as set in Windows' Display Properties  Appearance), and would like
your Images to nicely fit in? BMPTOICO will automatically adjust itself to your preferences.

New Image (256 Colors or more)
The three main Colors of your Scheme, 

. Button (and Form) Shade

. Button Highlight Shade

. Button Dark Shade

are automatically added at the end of the Default Big Palette: .

If our New Image is a Button, you can use your Scheme in the Buttonizer.

Existing Images, in the...
Buttonizer

You can set the Button's borders or bevels to your Scheme if you wish.

Editor
Your Color Scheme is Not added to any Palette, but you can easily Add its Colors to your list of Favorites:
How do I... Keep a List of Favorite Colors?

. Create a New Image in 256 or True Colors: the three Colors will be available at the end of the Big Palette (see 
above)

. Then, for each Color:
1    Select it as Active (Foreground if your New Image is an Icon)
2    Double-Click the Color Swatch to Edit it 
3    It will be the "New Color" in the Color Editing Form: Don't Change it
4    Check the    "My Favorites" Box in the "Add the New Color to..." frame
5    Click OK: the Color will always be available each time you Edit a Color.



 FAQ: Why does 16-bit Video Mode not Display Colors Correctly?
Back to: FAQ

Explanation
Monitor Display Colors are created from a Color's Red, Blue and Green levels; since each level can have a value 
of 0 to 255, it needs one Byte, or 8 Bits, to be described properly. To fit the RGB level values into 16 bits, they 
need to be squeezed into 5 bits each, and converted from/to 8 bits by the Application. Since each Video Card 
manufacturer has its own way of doing this, there are Display problems.

In BMPTOICO...
You will be mostly aware of the problem in the Editor: Some colors will not be displayed properly in the Editing 
Area. They will look as what the author intended, but the RGB values might be off by a few digits, so    both Show 
Color Use and Color Editing (which checks if the Color you want to Edit is present in the Image) might skip them.

Solution
Set your Video Mode to True Color (24- or 32-bit).

In Detail...
Images Opened from Disk Files

BMPTOICO tries its best to adjust the Displayed Colors to those of the File's Color Definition (Image Palette if 
the Image has 256 Colors or less, Pixel Definitions for True Colors ones) if it detected that your Video Card does 
not display the VGA 16 Colors properly , but it does not always succeed.

Other Images
Real Display Problems happen in the Editor when BMPTOICO has to read the Color data directly from the 
Display instead of from a File: 

- Icons Extracted from a File or a Library
- Screen Grab Bitmaps 
- GIF, JPG/JPE or WMF Files
- Cropped Images that were Shrunk or Blown (including Thumbnails)
- 16-bit Bitmaps

Show Palette in the Main Form
(Images with 256 Colors or less: Click the Palette Button, or Click File  Palette). The Colors will show OK, 
but the RBG values might be slightly wrong.



 FAQ: Why can't I Edit my 256 Colors Image?
Back to: FAQ

BMPTOICO tries its best to adapt itself to the Opened Image's Palette when the Video Mode is SVGA (256 Colors), 
but it sometimes misses the mark... or cannot do certain things because of Windows' own Palette Restrictions.    

...the Colors are Wrong when I Open it
Try Opening it again.    if the problem persist, try Opening an Icon, then your Bitmap, or vice-versa, until you get it 
right.    

If your Icon has more than one Format and they don't share the same Palette, the ones that are not Selected might
look wrong.    They will look OK when you Select them.

Even when the Colors are right, they might get wrong when Windows's focus is on another Form within 
BMPTOICO, or on another Application: Colors should be back to normal when you return to BMPTOICO's Main 
Form.

... I cannot Edit or Buttonize it
Because of Windows' own way of dealing with 256 Colors Palette, it Dithers all the Colors to its VGA16 Palette for 
most of the Painting Tools, and the result would be very far from what you want!    For this reason, Editing is not 
possible, neither is Buttonizing or Creating a New 256 Colors Image.

In fact, I don't seem to be able to do much...
If you read this Help file, you will notice that many of BMPTOICO's features are only available if your Video Mode 
is set to High or True Colors: this includes the Special Effects other than the Buttonizer, the Choice of Palettes 
when you Decrease Color Depth, the View All Limitations, etc..    Enough to tempt you into upgrading your system?



FAQ: Why can I "View" an Image, but not Open it? Or vice-versa?
Back to: FAQ

To be able to work faster while Loading the Images, BMPTOICO uses Windows' LoadPicture Statement, which has 
big limitations (and still has them in 32-bit Visual Basic...). 

This affects both the View All Module and the "View" item of the File Lists PopUp Menu.

But when you Open an Image into BMPTOICO's Main Form, it uses the File Data to recreate the Image for Display. 
This takes a little bit longer, but allows it to use many more types of Images on more Video Modes, with their proper 
Colors. 

Display Limitations
View All Module

Icons and Cursors: All are Displayed in a 32x32 Template (or Actual Size if smaller), and their Colors will be 
wrong if they need to be squeezed to a 32 x 32 display; they will be OK when you Open them.

Bitmaps and Metafiles:  All are displayed Actual Size if they measure 72 x 72 pixels or less; if bigger, they are 
Shrunk (reduced) to Fit within 72 x 72 pixels.

"View" PopUp Menu item
Icons and Cursors: All are Displayed in a 32x32 Template.    Same colors problem as above.
Bitmaps and Metafiles: are shown in Actual Size. 

Video Mode Limitations
 Those of your System...
 All Icons and Cursors are shown with the VGA 16 Colors. If they have 256 or True Colors, Windows might use 

four more solid colors in the View Module.    Don't worry, BMPTOICO will Open them with a Full 256 Colors Palette. 
Bitmaps are OK.

            

Image Formats Limitations
Bad Images are represented by a big X Icon, as they cannot be Opened. The "View" item is Disabled in the Main 

Form's PopUp menu.

 Web Files can be Opened, but not Viewed (the "View" item is Disabled in the Main Form's PopUp menu if you 
Right-Click a Web File Name).    If the Current Folder contains only files of these types, the View button (and 
the equivalent Global Menu item) is Disabled.

Big Bitmaps (over 500 pixels in Width or Height) are represented by a special Big! Icon in the View All module, 
but will be displayed correctly (as a Thumbnail) when you Select them; this conserves memory on older 
systems, and makes the module work faster. The Main Form's PopUp "View" menu item shows them Full Size.

Metafiles (.WMF) If your Video Mode is set to 16 or 256 Colors, they can be Opened only if they contain a Bitmap 
with 2 or 16 Colors (otherwise the Colors would be wrong).    Even if your Video Mode is OK, they may show 
with the wrong colors, and even not show at all, but they will be OK when you Open them.

16- and 32-bit Icons can be Viewed, but not Opened, as I am not sure if they are really legitimate.



FAQ: Why is BMPTOICO slow, especially while Opening Icons?
Back to: FAQ

To be able to display Icons properly, BMPTOICO uses the File Data itself, rather than just Load the Icon. Bitmaps are 
Loaded normally, and the speed at which they are loaded depends on their size.    If your computer is not too fast, be 
patient...

Images in 
 Video Mode... It can get even slower, because BMPTOICO has to tell    Windows to use the Opened Image's 

Palette as the System Palette. It does this by Saving a tiny (1x1 pixel) Bitmap containing the Palette, then ReLoading 
it immediately. This File, called    $$$PAL.DIB, is deleted when you exit BMPTOICO.    

The intensive use of Windows Graphic Functions in the Editor can also tax older systems: just be patient, espeically if
you run Windows on a notebook. 



 FAQ: Why does the Bitmap I Grabbed from Screen have the Wrong Colors?
Back to: FAQ

Explanation
 Windows can use only one 256-Color Palette at a time, and it sets it to that of the Picture that is sees as being "On
Top".

Solution
1    Make your Image TopMost in Windows

Select the Image in the Application that contains it. Some, like PaintShop Pro, are very good at 
maintainting the topmost picture, others are not.

2    Return to BMPTOICO
3    Now Click the Grab button.



FAQ: Why are the Colors in my 16-Colors Icon all Wrong?
Back to: FAQ

Explanation
This can happen if your Icon's Colors are not    all VGA 16, and your Video Mode is set to...

Windows will transform all Colors to its own Standard
Palette in both the Image and the Editor's Small 
Palette.

Windows will Dither the Colors in the Editor's Small 
Palette, but the Image will be OK. If you wish to use 
one of the Image's Colors,    use the Pick Tool to get 
it.

    
Solution

Set your Video Mode to High or True Color if you can.



FAQ: Can I Open Web Files in BMPTOICO?
Back to: FAQ

Yes!
BMPTOICO can Open GIF and JPG Files. It needs the VBJPEG.DLL and FILE.DLL Files in its directory or in 
your Windows\System Directory (both files are included in the BMPTOICO Zip File).

But...
They will be treated as Bitmaps internally, and can only be Saved as BMPs (you will need another application to 
Convert them back to Web Files: see below).

JPEGs can only be Opened if they were Saved with the "Baseline" process, which excludes Progressive and 
other types of JPEGs (this is a limitation of the VBJPEG.DLL file, not mine). Click "Info" in the Right-Click PopUp 
menu to find out if the file is "Baseline" or not. 

To List them

The "+ Web" CheckBox is Enabled if a Folder contains GIF and/or JPG/JPE files.    Check it to also List Web Files 
in the Bitmap List. 

Open them...
... as you would any other File: BMPTOICO will send them automatically to its Special Loading Module.    You may 
encounter a very, very rare GPF when you use that module to Open JPEG Files, there is nothing I can do about 
it... it is a bug in the DLL file, and I am not its author... Most Errors will be caught by the Special Loading Module.

To Convert back to Web files
These applications are both Freeware!

.    Image Converter
Opens BMP, GIF, JPG, WMF, ICO, Converts to BMP, GIF, JPG
Available from:    www.homeplansoftware.com.

.    BMPtoGIF
Converts only to 256 colors GIFs, but the Pro version can do much more, including editing.
Available from:    www.develcor.com/utilities/bmptogif.htm



FAQ: Can I work with Other Graphic Files in BMPTOICO?
Back to: FAQ

If you wish to use Graphic Files that are in a Format other than BMP/WMF/GIF/JPG, you must first Convert them to 
the one of these formats with another application, like...

.    PaintShop Pro (JASC Software)
Supports everything, except... ICO.
Available... all over the Internet!



FAQ: How can BMPTOICO use Long Filenames?
Back to: FAQ

Even if BMPTOICO is a 16-bit Application, it can use 32-bit Long Filenames thanks to the tiny CALL32.DLL 
file installed with it.    It is a Freeware File I found on CompuServe, together with the SAMPLE32.BAS File which 
contains all the coded needed. 

If you are interested in using it, Contact me, and I will be happy to share it.
 



FAQ: Is BMPTOICO "Y2K" compliant
Back to: FAQ

Yes! 
The only Routine that uses Dates is for the Trial period for Non-Registered Users. It has been fully tested for 2000,
including February 29.



How do I...?

    Change my Video Mode?
    Make an Icon from a big Bitmap?
    Make a Button?
    Merge two (or more) Icons in one .ICO File?
    Associate a File Extension with BMPTOICO?

    
[Editor]

    Add Text to my Image?
    Compare the Image I am Editing with other Images?
    Keep a List of my Favorite Colors?

[About BMPTOICO]
    Register?
    Report Bugs?
    Uninstall it?
    Learn about MyCat Software?

See also:    Frequently Asked Questions



How do I... Change my Video Mode?
Back to: How Do I...?

 Windows
You must first Exit BMPTOICO before Changing your Video Mode, as it will not work properly after the Change 
(it reads your System's Color Depth only once, when it starts).

If you have told Windows to "Show settings on Icon TaskBar", Right-Click the Display Settings Icon and Select 
a new Video Mode. 

Otherwise...
1    Click the Start Button
2    Select Settings
3    Select Control Panel
4    Click the Display Icon
5    Click the Settings Tab, then the Properties you want
6    You probably don't need to restart Windows, unless told so.

 Windows
1    Exit BMPTOICO
2    Select the Program Manager
3    Select the Main Group
4    Click the Windows Setup Icon
5    Select    Options, then Change System Settings
6    Select Display, then the Video Mode you want
7    You will need to restart Windows...

    



How do I... Make an Icon from a Big Bitmap?
Back to: How Do I...?

No problem... BMPTOICO includes a very intuitive Crop Function, which also allows you to use a Thumbnail View of 
the Bitmap . 

If you Open a Bitmap that measures more than 72 x 72 Pixels, it will automatically send it to the CROP Module, 
where you can easily define a smaller region that will become your Image for BMPTOICO.    If the Region you need 
does not fit exactly in the Size you need, you can Resize the Cursor to Shrink or Blow the Region under it.

Nice, but... I want to Crop a Rectangle Image...
BMPTOICO being mostly intended to design Icons, you can only Crop square Images. If you need a rectangle 
Image, for ex. for a Button, Crop it to the largest Size you need then, back in BMPTOICO's Main Form, use the 
Resize Wizard to Crop an even smaller Image (Select    the "No" Option for "Fit to Size"), and this time you are 
allowed Rectangles...



How do I... Make a Button?
Back to: How Do I...?

If you are still writing 16-bit Applications, your Programming Application might not let you add pictures to Windows' 
Buttons. One way to get around this is to use PictureBoxes as Fake Buttons. 

BMPTOICO lets you easily Create New Bitmap Buttons (New Image Wizard) or Transform existing Bitmaps into 
Buttons (Special Effects Menu).    In both cases, it opens its easy to use Buttonizer Module. 

For each Button, you need an Up and a Down version plus, if your Button needs to be Disabled, a Disable version.    
These pictures should not be Visible in your app, as they are only needed to store the buttons until they are used. For
the user to see your Button, you need another Picture (or Image), that will be Visible.

If you don't have too many buttons in your app, you can store them    into individual Image Controls and use the 
LoadPicture Statement (or its equivalent in other programming languages) to copy them to your Visible Button 
picture. If you have    a lot of Buttons, you might prefer to use a big PictureBox for all your Buttons, and use the 
Windows' BitBlt API function to copy the button you need to the Visible Button.



How do I... Merge two (or more) Icons in one .ICO File? 
Back to: How Do I...?

Perhaps, a long time ago, before you really understood Multi-Format Icons, you have designed two separate Icons for
your application: one is 16 x 16 Pixels, the other 32 x 32.    But... they are in two .ICO files, and your programming 
application will let you use only one (Form.Icon Property).    Now you want to put the two Icon Formats into one file.    

BMPTOICO does not have a Function for that, but here is a workaround that takes longer to explain than to actually 
do:

In the Main Form:
1    Open the first Icon, note its Dimensions, Color Depth, and the "Transparent" Color in BMPTOICO (Default is 

Grey).
2    Copy it to the ClipBoard (Top Button or File Menu)
3    Immediately Open the second Icon
4    Click the Add a Format Button (Top Button or File Menu)
5    In the New Format Wizard, set the Color and Size Option to that of the Clippped Icon, and make sure that the 

"Use Current Image" Box is NOT Checked (you need a blank template)
6    Click OK: the Editor will Open

In the Editor:
1    Select a Paint Tool
2    Select the Transparent Colors Option

Make sure that the Left Button Transparent Color is the same as the Color you want to be Transparent in the 
Merged Icon (Default is Grey), because the Icon in the Clipboard is not an Icon anymore, but a Bitmap, and its 
Transparency has to be redone by the Pasting functions 

3    Select the Move Tool
4    Click the Paste Transparent Button (the one on the right)
5    Click the    Button, or Edit  Commit Selection

6    Do any needed Editing
7    Save the Icon, making sure the "All Formats" Option is Selected. Or Click the Done Button, and Save the Image 
back in the Main Form.
 



How do I... Associate a File Extension with BMPTOICO?
Back to: How Do I...?

When you Associate an Extension with an Application, Windows will use the association to let you Open that 
application with the file already Opened when you Click on the File's Name or Icon.    Association with BMPTOICO is 
done in Windows, not BMPTOICO.

NOTE: It is not recommended to associate BMPs or WMFs with BMPTOICO, as there are applications better suited 
for working with them. But don't hesitate to associate .ICO or .CUR files with it!

How to do it...
    Done in Windows Explorer:

. Double-Click on an .ICO file: Windows will open its "Open With..." form; Follow its instructions.

. or, Click View  Options 
 File Types Tab. If "ICO File" is already listed: Click the "Edit..." button; otherwise, Click the "New Type..." button 

and follow the instructions.
. Help is available in Windows Help, the Topic is "associating, file types with programs".
. in the Explorer, the Image's icon will now be BMPTOICO's icon.

    Done in Windows File Manager:
. Highlight the filename, then Click File  Associate (if you double-click the filename, Windows will tell you 

the same thing).    Click the "Browse" button to find the file BMPTOICO.EXE on your hard drive, then Click 
"OK".

. Help is available in Windows Help  Search for Help on..., the Topic is "associating files".

. in the File Manger, the Image's icon will now be the generic "document-type" icon.

And now what...
Once a file format is associated with BMPTOICO, you can open the file in many ways:
. Double-Click on the filename in Windows Explorer or File Manager.
. Drag-and-drop the filename unto the executable filename BMPTOICO.EXE 
.  Drag-and-Drop the filename unto a Shortcut to BMPTOICO.EXE 

But...
You cannot Drag-and-Drop unto BMPTOICO while it is running... 

 



How do I... Add Text to My Image?
Back to: How Do I...?

You need to use the Text Tool in the Editor.

BMPTOICO's Text Function is unlike any other. Instead of selecting a Color, then Enter the Text and its attributes in a 
separate form, then Click OK to find out that the Text's Size or Color is wrong, in BMPTOICO you can see the results 
immediately and change them easily.



How do I... Compare the Image I am Editing with Other Images?
Back to: How Do I...?

BMPTOICO will let you Edit only one Image (and one Icon Format) at a time, but you might want to compare what 
you are doing with another Image, or with other Formats in the same Icon File.

Compare with the Other Formats in an Icon
In the Editor, Click Image  Zoom on other Formats; this item is Visible only if your Icon has more than one 
Format.

In the "ZOOM on Other Formats" Form, Select the Format you want to see in detail from the list at the right. Click the 
Magnifier +/- Button (at upper right of the big picture) to Zoom In or Out,    Check the Keep on Top Box to keep this 
Form over the Editor.

Compare with Another Image
Because of Windows Palette Restrictions, this feature is only available if your Video Mode is set High Colors or 
more.    Otherwise, more often than not, the Palette of the Image you are using for Comparison will    not be the 
same, and its Colors will all be wrong.

Use the ClipBoard
1    Open the Image you need for Comparison. If it is small enough, you can do it in BMPTOICO; otherwise, you 

can use any Graphic Application
2    Copy it to the ClipBoard
3    In the Main Form, Click Global  Show ClipBoard to Compare

                    In the Editor, Click Image  Show ClipBoard to Compare

Or, in BMPTOICO's Main form (BMPs and WMFs only):
1    In the Main Form, Right-Click the Filename of the Image you need for Comparison
2    Right-Click the Filename
3    Select "Show to Compare" in the Pop Up Menu

In both cases, the COMPARISON    Form will Display the Image: it will remain Opened until you Close it, or until 
you Exit from BMPTOICO.    You can Enlarge it up to four times, and Check a Box to "Keep it on Top".    If you wish 
to Show another Image for Comparison, you don't need to Close the Form: it will be updated with the new Image.   
If you are Showing the ClipBoard Contents, you can reuse the ClipBoard at this point.



How do I... Keep a List of my Favorite Colors?
Back to: How Do I...?

Some Colors are so lovely that you want to use them over and over again... BMPTOICO can keep a list of up to 16 
"Favorites" in its INI file, and make them available each time you run it.

Since the only time you might need them is when you Edit a Color in the Editor, this is where you Manage them.    The
"Favorites" Palette is part of the Color Editing Form.

Add a Color to the List
1    Edit any Color: the COLOR EDITING Form will Open.
2    Use the Scrolls or the Palettes to get the Color you want
3    Make sure the [Add New Color to...] My Favorites Box is Checked
4    Click OK (or Cancel).

Delete Colors from the List
1  Click the Clean Button under the Favorites Palette
2  A little Form will Open, with a List of your current Favorites.
3  Un-Check the ones you don't need anymore 
4  Click OK (or Cancel)



How do I... Report Bugs?
Back to: How Do I...?

Contact Information

BMPTOICO is now a big application... even if extreme care has been taken to Debug it, the odd bug might still be 
present.    If you find one, please report it to the author as soon as possible, explaining exactly what you were doing 
when it happened.

Being a graphics application, BMPTOICO needs all the Windows resources it can use, especially on systems with 
only 8 megs of memory, and /or systems that are on notebooks, and/or for Windows versions that are run from within 
another Operating System, for ex. Win-OS/2. 

BMPTOICO polls your resources at many strategic points, and will not let you access certain functions if your 
resources are too low.    But it cannot poll them all the time (otherwise performance would suffer) and Windows can 
still be crashed, but this is a very rare occurence (it never happened to me in over one year of testing). If you are 
concerned, you can always Click Help  Resources Check in the Main form (or in the Editor) to get the current 
state of your system.

You can also write to the author for other reasons... like compliments? Over the years, I have built a few lasting 
friendships this way.



How do I... Uninstall BMPTOICO?
Back to: How Do I...?

BMPTOICO being a 16-bit Application, you don't need to worry about Windows' Registry... 

If UNINSTAL.EXE is still in your BMPTOICO Folder, you can run it, or you can Delete all the Files you don't need 
anymore in your BMPTOICO Folder by hand.

If you have moved or copied the VBX and/or DLL Files Files to your Windows\System Folder, you should know if you 
need them for other Applications, and decide if you want to delete them or not: 
UNINSTAL will NOT touch them there, don't worry!
 
DLLs

.    CALL32.DLL (allows 32-bit Windows Functions to be used in 16-bit apps)

.    FILE.DLL (Opens BMP, GIF, and many other formats into VB apps; BMPTOICO currently only uses it to Open 
True Color BMPs on 256-Color Displays, and all GIFs).

.    VBJPEG.DLL (Opens JPEG files into Visual Basic apps)

.    VBRUN300.DLL (Visual Basic 3.0 Runtime Library) should NEVER be deleted once you have it, and should    
be kept in your Windows\System Folder. Many applications still rely on it. 

VBXs
.    BMPLST2.VBX (ListBox with Bitmaps)
.    PICBTN1.VBX    (Picture Button)
[Both Custom Controls are from Mabry Software]



    How To Register

        BMPTOICO 4.0
MyCat Software
© 1995-2000, Lucie Dorais

Trial Version Limitations
BMPTOICO's Trial version is not crippled in any way, except for the nagging screen upon opening and closing it.

BMPTOICO will stop running after the 30 days trial period is over, but will still show the nagging screen, so you can
enter the registration number if you got one.

Price
Only $25 US

 Price is $25 Cdn IF you live in Canada and Register via Snail-mail

Three Easy Ways to Register:

1      Via REG.NET, the Registration Network

·     From BMPTOICO itself: Click Help  About, then Click the "Register Online" Link, or Click the 
REGISTER ONLINE Now Button in the Nagging Form.

·     MyCat's Web site: www.mycatsoft.com 
Click the RegNet's "Register NOW" button on the Index page; in the Registration page, Select the 
BMPTOICO link. You can also follow the "Register Online" Link for BMPTOICO.

·      Reg.Net's Web site: www.reg.net
The BMPTOICO 4.0 page is: http://www.reg.net/product.asp?ID=6206

.      By phone: Call Reg.Net at      1 800 WWW2REG (1 800 999-2734) or (805) 288-1827. The 
Reg.Net ID for BMPTOICO is # 6206.

Credit Cards accepted: 

2    At the Soft Shop
        If you prefer to use SWREG's successor (GO SWREG in CompuServe), you can also do it:

·      www.swreg.org
The BMPTOICO 4.0 ID code is: 171bmpico4. or Search for "BMPTOICO"

3      Via Snail-mail
(see Contact). Please make all cheques, money orders or bank drafts payable to Lucie Dorais, NOT to MyCat 
Software. You can use the ORDER.TXT file included in the Zip file (this can be printed automatically from the 
Nagging Form).

Upon Registration
You will receive a unique Registration code, which can be entered in the Nagging Form (Click the ENTER your 
Registration Code Button).

MyCat Software
BMPTOICO is not the only app I have written... see this List!

Special Thanks to...
. Jim Deutsch, of the Visual Basic Programmer's Journal, for his Output to BMP routines.
. Michael Coker, in England, for continued support and friendship since version 2.0.
. John Gaskill, from California, for last-minute testing
. Other Beta-testers: 



Version 4.0: Rick Raubenheimer in South Africa, Robin Barber in England, and Steffen Pietsch in Germany.
Versions 2.0 and 3.0:    Joe Dacy II in Texas 

· Masayuki Koba and Dara T. Khani for creating Neko, My (virtual) Cat.



 Contact Information

Web site
www.mycatsoft.com

 : You can Highlight the web site above, Copy it to the ClipBoard, then Paste it into your Browser's URL textbox

 : You need to Write it down... Copy in WinHelp will Copy the whole page!

E-mail
ldorais@mycatsoft.com or ldorais@cyberus.ca 

[first char. is a lower case "L"]
There are Direct Links in BMPTOICO's About Form (menu Help > About) and on my Web site.

CompuServe (slower reply time, and I might eventually cancel my subcription)
CIS ID: 76440,623  [comma between the two numbers]
from outside CIS: 76440.623@compuserve.com    [period between the two numbers]

Snail-mail
Lucie Dorais
603 - 222 Guigues
Ottawa, Ont.
K1N 5J2
Canada



    MyCat Software

MyCat Software specializes in Utilities for Icon Lovers that also enjoy a good game once in a while. All programs are 
available on MyCat's Web site, as well as on CompuServe and other Internet Shareware sources. All require 
VBRUN300.DLL and have a low cost; some are even freeware. 

CHAINLINK
A very challenging Solitaire game. Move all cards to the Top by building Chains of cards of the same Suit. Use the 
mouse or the keyboard. Big card design option, Collection of winnable games! Search CHAINLNK.ZIP    ($15 US)

ICOS256
A trimmed-down version of BMPTOICO ver. 3.0, which only opens Icons (no conversion, editor, etc). Can also 
extract 32x32 icons from EXE/Libray files.    Freeware. Search ICOS256.ZIP

ICOEDIT
An older style Icon and Bitmap Editor, which can only use 16 colors. BMPTOICO 4.0's Editor incorporates all its 
features (and more!). Ver. 1.5 uses Long Filenames if your system is 32-bit. Search ICOEDIT.ZIP    ($20 US)

HTML COLORS
Designed to help Web authors quickly select background, text and link colors, or edit the HR        line. Includes 600 
predifined colors to chose from, and you can add more! Background patterns can also be loaded.    Test your 
choices immediately in a Web look-alike page (Netscape 2.0...), hen copy the tags to the Clipboard (or keep them 
in a tag list for future use).    Search HTMCOLOR.ZIP ($15 US)

PALEDIT
A Windows Paint (or PaintBrush) palette editor, with many additional features. Load and Save palettes. Use Hue, 
Saturation, Luminosity as well as RGB.    See the detail of a dithered color. View the colors in 16 or 256 color mode.
Mix two colors to create a new one. Insert a Clip from a drawing program picture to try to match a color. Edit Color 
or Black and White palettes. Build palettes from PAL files other than PaintBrush. Search PALEDIT.ZIP ($15 US)





But'n Style To Paint, Use Button...
Outlined,
Filled

Left: Paint with Left Foreground Color
Right: Paint with Right Foreground Color,
      or Transparent Color (Icons in Alt. Option)

2 Colors 
(Foreground 
Colors only)    

Left: Border will be Left Foregr. Color, 
        Filling will be Right Foreground Color
Right: Border will be Right Foregr. Color,
        Filling will be Left Foreground Color 



Fake Transparency
  For Icon Files that are really Bitmaps 

with an .ICO extension, Windows' Desktop 
and Explorer will Set Transparency to the 
Color of the Upper Left Pixel.



Transparency
Icons and Cursors only. 
Transparent Pixels let anything 
under them to show through.



No Edit possible
If your Video Mode is set to 16 or 256 Colors,
and your Image has more than 16 Colors,
Windows Dithers any Color that is not part of its
16-Colors Standard Palette, so the Paint Tools 
dont' work properly.



Icon Format
Icon Resource files can contain more
than one Icon, called an Icon Format. 
Only 32-bit Windows can use them.



Web Files
GIF and JPG Files can be Opened.
Check the "+ Web" Box to List them.



New Image Wizard 
Resize
Color Depth Menu 
Special Effects Menu
Add a Format
Delete a Format



View Area
The Image being Cropped.
Use the Scrolls, or Click the
Thumbnail to change the
portion under View.



Cropped Image
This is the resulting Image 
of the Cropped area.



Move buttons
Click to move the Cursor around: the 
Cropped Image is immediately updated.



Step Scroll
Change the number of pixels 
by which the Cursor moves. 



Zoom Button
See a Blowup of the Cropped Image.



View Menu
Full, Zoom: Same as the Buttons.

Help Menu
Opens the "Crop BMPs" Topic.



Resize Cursor Function
Shrink or Blow the area under the Cursor
so that it better fits the Selected Crop Size. 
Click the Arrow Buttons to Resize,    and 
the "=" Button to Reset the Cursor to Crop 
Size. The Scroll Changes the number of 
pixels by which the Cursor resizes.



Cursor Border CheckBox
The Cursor is normally the Inverted 
Color of each Pixel. 
Check this Box to make it all Black.



Done button
Sends the Cropped Image 
to BMPTOICO's main Form.



Crop Size
Select the Size of the Cropped 
Image from the List.



Cursor
What is under the Cursor will be
part of the Cropped Image.



View Scrolls
Visible if the Bitmap being Cropped 
is larger than the View area; use 
them to see more it.



Thumbnail View
If the Bitmap being Cropped is larger
than the View Windows, Click this
Image anywhere to Reset the View.



Thumbnail Button
Click to immediately Open the
Thumbnail in BMPTOICO.



Full View
See the Complete Bitmap.
Disabled if the Bitmap fits
into the View Window. 



Opened Image
Image Currently in Memory.
If the Icon or Cursor has more than one 
Format, this is the Selected one. 



Edit Button
Opens the Editor. 
Disabled if the Image cannot be Edited.



Convert Button
Convert BMPs to ICOs, or vice-versa,
with the Conversion Wizard.



Save as... Button
Opens the Save Wizard.



Zoom Button
See a Blowup of the Opened Image.
The button's picture says if the Image has
Transparent pixels , or not 

.



Palette Button
Shows All the Colors in the Image's Palette,
if the Image has one (256 Colors or less).



Resize Button
Opens the Resize Wizard.



ClipBoard Button
Copies the Image in memory
to the ClipBoard.



Unload Button
Unloads the Opened Image 
from Memory. 



View All Button
View All Files in the Currently Selected
Folder in the View All module. 



Icon Extractor Button
Extract Icons from Executable files or 
Libraries with the Icon Extractor module. 



Grab Screen Button
Takes a Full Screen Capture.



New Image Button
Opens the    New Image Wizard. 



DeskTop Simulation Button (Toggle)
Check your Icons or Cursors on a Simulated
Desktop. Disabled if the Image is a Bitmap.



Exit Button
Exits BMPTOICO.



Desktop Simulator
Check how your Icons or Cursors 
will look on Windows' Desktop. 
Not Visible if the Image is a Bitmap.



Icon Formats List
See All Formats in your Icon. Click
on the Format you wish to work on.
Not Visible if the Image is a Bitmap.



Add Format Button
Add a Format to your Icon.
Not Visible if the Image is a Bitmap.



Delete Format Button
Delete the Selected Format 
from your Icon.
Not Visible if the Image is a Bitmap.



Drive and Folder Lists
Currently Selected Drive and Folder.
Use them (Double-Click) to Navigate 
your Drives.



Icon File List
Shows all .ICO and .CUR files 
in the Currently Selected Folder



Bitmap File List
Shows all .BMP and .WMF (or JPEG) 
Files in the Currently Selected Folder.



Open Path Display
The Full Path Name of the currently Selected Folder.
If the Open Path is Read-Only, the Full Save Path 
is displayed under it (see Navigation). 



Web CheckBox
Enabled if there are Web files in the Current 
Folder: Check it to List them in the right List.
Can I Open Web Files in BMPTOICO?



Video Mode Info
Your Current Video Mode. 



Tool Tips
Useful Tips in the Main Form, the Editor,
the View All Module and the Icon Extractor.



Top Menu
File: most items need an Opened Image
Global: items available any time
Color Depth: Change Number of Colors in Image
Special Effects: Change Aspect of Image
Help: Available any time (or Press [F1])



Help Button
Opens this Help File at the
Contents page.



Don't Synchronize Image and Folder
Click this Toggle Button to Change the
Current Folder (and Save Path) without 
Unloading the Image from memory.
Default is: Synchronized, reset each
time you Open/Create an Image.



Resized Image
Updated each time you change something.



Available Size Options
Offered for all Images. The Current 
Size of the Image (in BMPTOICO's 
Main Form) is Disabled.



Custom Size Scroll
Enabled only for Bitmaps.
Range: 16 x 16 to 72 x 72.
If    the "Keep Aspect Ratio" 
Box is Un-Checked, you get 
two Scrolls. Width and Height.



Aspect Ratio CheckBox
Enabled only for Bitmaps of Custom Size.
Check to maintain the Width vs Height
Ratio, Un-Check to set them independently.



Yes, Fit to Size
Select this Option if you want
your Image to Fit to the New Size.



Don't Fit to Size
Select this Option if you don't want
your Image to Fit to the New Size.



Center CheckBox
Enabled only if the New Size is Bigger than
the Current Size, and No Fit is Selected.



Crop Scrolls
Visible only if the New Size is Smaller than
the Current Size, and No Fit is Selected. 



Zoom Button
See a Blowup of the Resized Image.



Reset Button
Resets the Image to its 
Current Size in the Main Form.



Custom Size
Enabled only for Bitmaps.
Range: 16 x 16 to 72 x 72.



New Format Image
Reflects the Size, but not necessarily
the Colors (for ex. if they are less than
those of the Current Format).



Color Options
The Options which are not available for
a given Size (they are already present
for this Color) are Disabled. 



Size Options
The Options which are not available for
a given Color Depth (they are already 
present for this Size) are Disabled.



Formats Button
See a quick List of the Formats 
already present in the Icon. 



Use Current Image CheckBox
Check to keep the Current Image for the 
New Format (Default), Un-Check to get a 
Blank Image. 



OK Button
Sends the New Format 
Image to the Editor.



Images
Click an Image to Select it.



File PopUp Menu
Opens when you Right-Click an Image;
same as File Menu on top. 



View Options
Select to View All ICO/CUR Files,
or View All BMP/WMF Files.



Scan Buttons
Use them to Navigate. Enabled
if there are more than 20 ICOs
or 15 BMPs in the Folder.



Position Info
Virtual Image Numbers for the Current
Page, and Current Image Number.



Top Menu
File: same as the PopUp Menu
Help: Opens this file at the View All page 



Open Button
Click to Open an Image into BMPTOICO.
Disabled if the Image cannot be Opened.



Search Button
Click to quickly Find an Image
by Number or Name. 



All Icons Extracted from the File 
Click an Icon to Select it. 



Icon PopUp menu
Opens when you Right-Click an Icon;
same as Icon Menu on top.



Top Menus
Icon: same as the PopUp menu.
File Types...: select only those you want.
Help: opens this file at the Extractor page.



Icon Name
The Name of the Selected Icon 
if the Icon Library File uses them. 
If not, BMPTOICO makes one up.



Scan Buttons
Use them to Navigate. Enabled
if there are more than 27 Icons
in the File.



Position Info
Image Numbers for the Current
Page, and Current Image Number.



Note from BMPTOICO
Text depends on Selected File
and your Current Video Mode.



Drive and Folder Lists
Currently Selected Drive and Folder in
the Icon Extractor module. Use them 
(Double-Click) to Navigate your drives.



File Lists 
Default extensions available:
(Left): .EXE, .CPL, .DRV,
                        .SCR, .VBX, .OCX
(Right): .DLL, .ICL, .NIL



Open Button
Click to Open an Icon into BMPTOICO.
Disabled if the Icon cannot be Opened.



Search Button
Click to quickly Find an Icon
by Number or Name (it the File
contains Icon names). 



Show only Files with Icons
Check this Box to List only the Files
that have Icons (Win 3.x Icons only).



Button Styles
Select a Style for your Button.



Button Actual View
Automatically Updated
when you change something.



Resize CheckBox
Check to make your Image fit within the
Button Borders if its Margins are not 
wide enough.



Button States
Up (Normal)
Down (Depressed)
Disabled



Zoom Button
See a BlowUp of your Button. 



BEVELLED Style Options
You can Change the Bevels' Size
and, in certain cases, their Colors.



Cursor in Main Form
This Cursor has 16 Colors.



Dummy Control
Click it to Test the Cursor.



Cursor in Test Form
The Cursor has been Decreased
to 2 Colors for Testing only.



Editing Area
Where you do the Editing. The Size of
Individual Pixels depends on the Size
of the Image. The Transparent Pixels
are indicated by Dots (can be turned 
On/Off in the Options Menu).



Image, Actual Size
The Image being Edited. Updated as 
soon as you Change something.



Undo To... State
State of the Image when you last 
Changed Tool. 
Double-Click it to revert to that State.



Move Tool      [CTRL+M]
Allows you to Move/Copy a Selection,
and Enables the Move Functions
Nudge, Flip, Rotate, Cut, Copy, Paste



Magnifier Tool
Zoom In on the Image for easier
Editing.



Small Palette
If the Image has 2 or 16 Colors: contains
      all Colors in the Image's Palette.
If it has more, contains the first 16 Colors
      in a Palette.



Foreground Colors
Colors used when you Paint with the Left or Right
Mouse Buttons. Only Colors available if you Edit
Bitmaps. Click the Squared Arrows to Swap Buttons.



Alternate Colors
Use Left Button to Paint Foreground,
Right Button to Paint Transparent.
Not Visible if the Image is a Bitmap.



Transparent Colors
Use Left Button to Paint Transparent,
Right Button to Paint "Screen Inverse".
Not Visible if the Image is a Bitmap.



Mix Buttons
For 2- and 16-Colors Images, the Left
Button will Paint a Solid Color, the Right
one will "Mix" the two Foreground Colors.
The Mix Function works differently for
256/True Colors Images: see Mix Colors.



Undo Button      [CTRL+Z]
Click to Undo the last Operation;
Enabled only if it can be done...
[Caption changes to REDO for most
Undoes]



Check Transparency Button
Click to see which pixels will 
be Transparent in the Icon or 
Cursor. Disabled for Bitmaps.



Cancel Button
Click to Cancel Editing 
and Discard All Changes.



Done Button
Sends the Edited Image 
to BMPTOICO's main form.



Pixel Information
Position and "What Is" Information
on the Pixel directly under the Mouse
Pointer in the Editing Area.



Image Information
Dimensions, Color Depth, and
Current Magnification Factor of
the Image.



Color Information
RGB values and Color Swatch of Color
under the Mouse Pointer (Editing Area, 
Paint Colors, or Palettes).    Can be turned 
On/Off in the Options Menu.



Menus
Image, Tools, Edit (Move Tool), 
Undoes, Options, Help (no topic)



Save As... Button      [CTRL+S]
Enabled as soon as you change
something. Click to Save the Image.



Pick Color Tool      [CTRL+I]
Pick a Foreground Color from the Image.



Draw Tool      [CTRL+D]
Paint Pixel by Pixel.



Line Tool      [CTRL+L]
Paint Lines.



Fill Tool      [CTRL+F]
Fills a closed area.



Swap Tool      [CTRL+W]
Swap two Colors in the Image.



Rectangle Tool
Draw a Rectangle (or a Square).
The Arrow Button will Fly-Down
all three Styles.



Circle Tool
Draw a Circle (or an Oval).
The Arrow Button will Fly-Down
all three Styles.



Text
Quickly Add a Text to your 
Image with the Text Tool.



Edited Color
Color currently being Edited
(Foreground, or in a Palette).
Click it to Reset the New Color
to it, and start over. 



Flash Button
This Button is visible only if the Color
being Edited was Found in the Image.
Click to Show its Use in the Image again. 



Auto-Replace CheckBox
Visible only if the Color being Edited was Found
in the Image. Must be Checked for BMPTOICO to
Automatically Replace the Color being Edited
with the new one in the Image.



Scrolls
Use to Modify the Red / Green / Blue levels
(or Hue / Saturation / Luminance values) in
the Color. You can also enter Values in 
the Boxes at the Right of the Scrolls.



RGB Tab
Select if you want to modify the
Red / Green / Blue levels in the Color.



HSL Tab
Select if you wish to Modify the Color
by changing its Hue (Shade or Tint), 
Saturation (Purity) or Luminance
(Brightness) Components.



New Color
Current State of the Edited Color, 
updated when you use    the Scrolls 
or Select a Color from a Palette at right.



Hex CheckBox
Click the Hex Box to Display and
Enter the RGB/HSL values in 
Hexadecimal instead of Decimal.



Add to + Palette
Check this Box if you want the New Color
to be displayed in the + Palette under the
Pool Palette (avaialble only for True Color
Images): it will remain there as long as the
Image is in memory.



Add to your List of Favorite Colors
Check if you want to Add the New Color
to your Favorites List (Available each
time you use BMPTOICO).



Pool Palette
Select a New Color by Clicking anywhere.



Win Standard Palette
Click any Color to Select it. Quicker than 
using the Pool for those 16 Classics...    



Favorites Palette
All Colors Currently in your Favorites List.
Click any Color to Select it. 



Clean Favorites Button
Click to open the Favorites Manager
and Delete those Colors you don't need
anymore (or make room for new ones).



Palettes Button (Toggle)
Click To Display the Palettes
at the right, Click again to Hide 
them.




